PV*SOL® Expert
Version 6.0
Design and Simulation of Photovoltaic Systems
Manual
Disclaimer
Great care has been taken in compiling the texts and images. Nevertheless, the possibility of errors cannot be completely eliminated. The handbook purely provides a product description and is not to be understood as being of warranted quality under law. The publisher and authors can accept neither legal responsibility nor any liability for incorrect information and its consequences. No responsibility is assumed for the information contained in this handbook.

The software described in this handbook is supplied on the basis of the license agreement which you accept on installing the program.

No liability claims may be derived from this.

Making copies of the handbook is prohibited.

Copyright and Trademark
PV*SOL® is a registered trademark of Dr. Gerhard Valentin.

Windows Vista®, Windows XP®, and Windows 7® are registered trademarks of Microsoft Corp. All program names and designations used in this handbook may also be registered trademarks of their respective manufacturers and may not be used commercially or in any other way. Errors excepted.

Berlin, 30.01.2013

COPYRIGHT © 1993-2013 Dr. Valentin EnergieSoftware GmbH

Dr. Valentin EnergieSoftware GmbH
Stralauer Platz 34
10243 Berlin
Germany
Tel.: +49 (0)30 588 439 - 0
Fax: +49 (0)30 588 439 - 11
info@valentin.de
www.valentin.de

Valentin Software, Inc.
31915 Rancho California Rd, #200-285
Temecula, CA 92591
USA
Tel.: +001 951.530.3322
Fax: +001 858.777.5526 fax
info@valentin-software.com
http://valentin-software.com/

Management: Dr. Gerhard Valentin
DC Berlin-Charlottenburg, Germany
HRB 84016
1 Program Series PV*SOL

The PV*SOL series supports the planner in the design of photovoltaic systems by dynamic simulation and yield calculation:

- grid connected photovoltaic systems

- grid connected photovoltaic systems using full feed-in or net metering

- off-grid systems (Net Metering)

- off-grid systems (Net Metering)

- 3D-visualization:
  - Module covering
  - Module mounting
  - Module wiring
  - with detailed shading analysis

→ See also: http://www.valentin.de/en/products/photovoltaics
2 New in PV*SOL Expert

This version will include the following new features:

Version 6.0

In the 3D visualization:

Cable plan
- Visualization of a cable plan with various views and idealized presentation of module connection cables, string cables and DC trunk cables as well as bundles, T-plugs, generator terminal boxes, coupling boxes and cable grommets
- Automatic set up of the cable plan by means of node-string system or generator connection box concept (short cable route)
- Module connection cables for every second module possible
- Manual drawing of module connection cables
- Cables can be laid around obstacles
- Precise optimization of the cable cross section
- Precise calculation of cable losses
- Output of the cable lengths
- Page preview for setting the number of pages and printout in project report

Additional new features:
- Aligning of strings in the configuration
- Free selection of the textures for all 3D objects
- Use of your own, true-to-scale textures makes it possible to adjust the dimensions of the tiles.
- Centered, significantly easier scaling of the attic stories of buildings and shed tooth roofs as well as walls and chimneys (ridge remains centered).
- Multiple copying of 3D objects and copying of other surfaces of a 3D object
- A wide range of settings are now saved throughout the entire program

PV*SOL Version 5.5
- The economic efficiency calculation for systems connected to the grid has been adjusted for the new EEG 2012 (German renewable energy act).
New in PV*SOL

- New climate data from DWD (meteorological service) for Germany using the averaging periods 1981-2010
- Input of the displacement power factor (Cos Phi) for the provision of reactive power
- Power control for small systems

In the 3D visualization:

- Configuration of several mounting surfaces in the 3D visualization
- Manual configuration in the 3D visualization
- New 3D objects: open areas and inclined open areas for planning mounted systems on the ground (maximum dimensions 300 x 300 m)
- Optimization of module configuration (e.g. meandering course)
- Align 3D objects
- 3D objects planned for the open area can be rotated together
- New textures for a realistic representation of the 3D system
- The assembly system can now also be edited by means of a right click on a row of modules
- For wide-scale blocking, restricted areas can now also be positioned over other objects, without resulting in a collision
- Solar azimuth angle and elevation angle are now also updated in the dialog box "Position of sun" when the time is changed.
- Entries in the losses dialog box can be transferred to all generators
- US unit system is available

-> Also see: http://www.valentin.de/produkte/photovoltaik
3 Software Management

3.1 System Requirements

- Internet access
- Processor: 2.5 GHz Pentium PC
- Memory: 2048 MB
- Hard disk drive: 700 MB
- Monitor resolution: mind. 1024 x 768 Pixel
- Graphics: 3D, DirectX– compatible, 256 MB, OpenGL, version 1.1 (needed for Photoplan)
- Software: DirectX, version 9.0c; .net-Framework: full framework Version 4.0

To run the program, you must have read and write rights to the PV*SOL® program directory.

PV*SOL® adopts the formats for currency, numbers, time and date set in the country settings of Windows' control panel.
These formats also appear on print-outs. It is important for the operation of the program that separators for thousands and decimals are different.
3.2 Activation of the Programme

Menu Help > Info > Registration > button Change Registration

3.2.1 Serial Number

Menu Help > Info > Registration > button Change Registration

If you have purchased the program, you will have a serial number. This is made up of a combination of digits and letters, which you will have to enter without any spaces in between, but including the special characters (hyphens).

You will find the serial number either on the CD case or on the invoice. Alternatively, if you made your purchase online, you will have been notified by e-mail.
3.2.2 Program ID

The program ID is allocated specifically for your computer and is only valid for use on your computer. A valid serial number, issued on purchase of the program, is required to obtain an ID.

The program ID is automatically provided as soon as you enter the serial number.

It is not possible to enter the program ID yourself.

You will need to let us know the program ID when registering, so that we can send you your key code.
3.2.3 Request the Key Code

Menu Help > Info > Registration > button Change Registration > (1.) button OK

You can activate your program in two different ways.

Request a Key Code Online

This method requires that your computer has internet access.
Click on the Online button to open a form, where you can enter all the information required to receive a key code. The fields marked with an * must be completed.
After you have completed the form, you can send it straight off – the recipient's e-mail address is entered automatically for your convenience.
After sending the e-mail, the activation key code is displayed. Additionally, this key code will be sent to the given email address.

Request a Key Code by Telephone
If you do not have a fax or e-mail, you can request the key code by phone. In this case, you will need to give us your program ID when you call.
3.2.4 Enter the Activation Key Code

Menu Help > Info > Registration > button Change Registration > (1.) button OK > (4.) button OK

Once you have received the key code, enter the key code into the input field "4. ".

Click the OK button. You will receive a message, confirming that your program has been activated.
3.3 Licensing Provisions

Menu Help > Info ... > General Information > View License

The license is displayed as .pdf file.
3.3.1 Licensing Terms

How many times can the program be installed?

The number of permissible installations corresponds to the number of licenses you have purchased. If, for example, you have purchased a single-user license, you may install the program on one workstation.

In addition, you can activate the program on a second computer, e.g. a laptop. However, this is only possible on the condition that the two installations are not used simultaneously.
3.3.2 Maintenance agreement

To make sure that you always work with the latest version of our programs and have the latest component data available, we recommend that you take advantage of our Software Maintenance Agreement (http://www.valentin.de/en/sales-service/customer-service/software-maintenance-agreement (This link will open in your browser.))

The software maintenance covers:

- Download of software updates, i.e. new program releases,
- Download of new component databases e.g. PV modules or inverters.
- Responding to general questions regarding delivery, serial numbers and activation of the software program/s and updates, as well as the ability to access component data.
4 Bases of Calculation

This chapter contains information on the bases of calculation for the following topic areas:

- Radiation processor
- Power output of the PV module
- Inverter
- Linear temperature model
- Dynamic temperature model
- Output losses
- Evaluation parameters
- Economic efficiency calculation
- Design recommendation
4.1 Radiation Processor

In the supplied climate files, radiation to the horizontal plane is given in watts per square meter of active solar surface (radiation to the horizontal plane). The program converts this to the tilted surface during the simulation in the radiation processor and multiplies it by the total active solar surface. Possible shading reduces the irradiation.

The radiation processor must split the radiation into diffuse and direct radiation. The splitting is carried out according to Reindl's radiation model with reduced correlation. [Reindl, D.T.; Beckmann, W. A.; Duffie, J.A.: Diffuse fraction correlations; Solar Energy; Vol. 45; No. 1, p.1.7; Pergamon Press; 1990]

When converting the irradiation onto the tilted surface, the anisotropic sky model by Hay and Davis is used. [Duffie, J.A.; Beckmann, W.A.: Solar engineering of thermal process; John Wiley & Sons, USA; second editions; 1991] This model takes into account an anisotropy factor for circumsolar radiation and the ground reflection factor entered in the program (Albedo).

To convert the direct share of solar radiation in relation to the PV array, taking into account the active solar surface from the direct solar radiation to the horizontal plane, the position of the sun relative to the PV area must be calculated from the height of the sun, solar azimuth, PV array tilt angle and PV array azimuth. The height of the sun and the solar azimuth are determined on the basis of the date, time and latitude. The tilt angle and azimuth of the PV array are entered in the program.

The radiation without shading results from the direct and diffuse share together.

The radiation to tilted PV array surfaces takes into account possible shading of the array. The shading is also split into diffuse and direct radiation. The diffuse share is determined proportionally to the shaded area independent of the height of the sun and the solar azimuth. The direct irradiation to the PV area is reduced by the duration of shading in each calculation step.

The radiation to tilted PV array surfaces is reflected at the module surface. The direct radiation share is reflected depending on the position of the sun and the incident angle modifier of the module. The incident angle modifier for diffuse radiation is set in the program. The resulting radiation is the radiation minus reflection.
4.2 Power Output of PV Module

By specifying the module voltage, the power output of the PV module can be determined from the irradiation to the tilted PV array surface (without reflection losses) and the calculated module temperature.

Image 1 shows the module output of a typical 100 W module with a module temperature of 25 °C for various irradiation levels. The top curve shows the module output under standard test conditions (STC). It can be seen that the module supplies its maximum output of 100 W with a voltage of c. 17 V. This working point of the module is called the Maximal Power Point (MPP). It must be determined for all irradiation levels and module temperatures.

Image 1 Output curves for a 100 W module with various irradiation levels

One requirement of a PV system is that for a given irradiation and module temperature the module voltage is regulated so that the modules work at the MPP. This task falls to the inverter.

On the assumption that the modules are operated in MPP operation, PV*SOL® determines the power output of the PV module from the power output of the module under standard test conditions and the efficiency characteristic curve of the module. The efficiency characteristic curves are generated from the data on part load operation.

Image 2 shows the typical course of module efficiency at various temperatures.

Image 2 Module efficiency at various module temperatures

The temperature dependency of the curve is determined from the characteristic curve at 25 °C ($\eta_{PV, MPP} (G, T_{Module}=25 \, ^°C)$) and the output temperature coefficient $d\eta/dT$:

$$\eta_{PV, MPP} = \eta_{PV, MPP} (G, T_{Modul} = 25 ^°C) \cdot [1 + \Delta T \cdot d\eta/dT]$$

If the MPP of the module cannot be maintained, the working point of the module must be calculated from the UI characteristic curve field (see image 3).
The efficiency of the modules also takes into account the following losses:

- due to deviation from standard spectrum AM 1.5,
- due to mismatch or reduced yield as a result of deviation from manufacturer information and
- in diodes.

These output losses are deducted percentagewise from the module output. In addition, the reflection losses at the module surface must be evaluated as module losses.

1 Standard test conditions: 1000 W/m² vertical radiation, 25 °C module temperature and radiation spectrum AM 1.5 Module output at STC Maximal power point (MPP) Efficiency characteristic curves
4.3 Inverter

The inverter has two functions. On the one hand, the DC generation of the PV modules is transformed to the voltage and frequency of the public power grid in the inverter. On the other, the integrated MPP tracker ensures that the PV array is operated at the Maximum Power Point (MPP).

Conversion to DC and AC is lossy. Via the efficiency characteristic curve, PV*SOL® calculates the output power depending on the input power.

Image 4 shows the typical course of a relative efficiency level. The output power of the inverter is determined as:

\[ P_{AC} = P_{DC} \cdot \eta_{Nenn} \cdot \eta_{rel} \]

In order to simulate the MPP tracking of the inverter, the program checks at every calculation step whether the module MPP voltage can be set by the inverter.

If the MPP voltage is outside the MPP tracking range of the inverter, or if several arrays are connected to one inverter with different MPP voltages, the controller lowers the UI characteristics of the modules until the working point has been found at which the maximum output can be obtained from the PV array.

Image 4 Relative efficiency level of an inverter

In addition to the efficiency characteristic curve of the inverter, PV*SOL® takes into account the MPP matching efficiencies, the stand-by and night-time consumption and the input power threshold beyond which the inverter supplies power. All factors are taken into account in the inverter efficiency.
4.4 Temperature Model

The temperature of a PV module is of great significance when calculating the power output. An increase of 10 °C results in a power loss of around 5%.

To determine the module temperature, the thermal balance equation is resolved in every time step of the dynamic temperature model. This process requires the current wind speed of the time step. If this is not included in the climate data record, a linear temperature model dependent on outside temperature and irradiation is automatically selected.
4.4.1 Linear Temperature Model

In this model, the module temperature has a linear dependence on the irradiation $G$ according to:

$$T_{Modul} = T_a + k \cdot \frac{G}{G_{STC}}$$

The value of the constant $k$ depends upon the type of module setup and a parameter for the maximum achievable heating at maximum irradiation ($G_{STC} = 1000 \, \text{W/m}^2$) compared with the outdoor temperature $T_a$:

- Free-standing installation: $k = 20^\circ \text{C}$.
- Roof integration, rear ventilation: $k = 30^\circ \text{C}$.
- Roof or facade integration, no rear ventilation: $k = 45^\circ \text{C}$. 
4.4.2 Dynamic temperature model

Solution for the thermal balance equation

In order to take into account the thermal inertia, each simulation time step (1 hour) must be divided into multiple small time steps $dt$, in which the following differential equation is solved using the $dT_{\text{Module}}$. In order to find the solution even under extreme conditions (e.g. a jump in the radiation from 0 to 1000 W / m²), $dt$ is set for each calculation set and may be as small as a few minutes.

$$m_{\text{Module}} \cdot c_{\text{Module}} \cdot \frac{dT_{\text{Module}}}{dt} + P_{\text{el}} = \dot{Q}_G - \dot{Q}_S - \dot{Q}_K$$

With

$$\dot{Q}_G = \alpha \cdot G \cdot A_{\text{Module}}$$

$$\dot{Q}_S = f_E \cdot \varepsilon \cdot A_{\text{Module}} \cdot \sigma \cdot (T_{\text{Module}}^4 - T_a^4)$$

$$\dot{Q}_K = f(A_{\text{Module}}, T_{\text{Module}}, T_a, v_w, l_{\text{char}})$$

The following sizes are may be used:

$m_{\text{Module}}$: Module dimensions

$A_{\text{Module}}$: Module area

$c_{\text{Module}}$: Heat capacity of the module

$T_{\text{Module}}$: Module temperature

$Q_G$: Absorbed power

$Q_S$: Convection

$Q_K$: Radiated thermal output

$l_{\text{char}}$: Characteristic overcurrent length

$\alpha$: Absorption coefficient

$\varepsilon$: Emission coefficient

$v_w$: Wind speed

$T_a$: Ambient temperature

$P_{\text{el}}$: Electric power output

$t$: Time

$\sigma$: Stefan-Boltzmann constant
\( f_E \): Installation factor

Influence of the module installation on the calculated module temperature

In addition to meteorological conditions \((G, T_a, v_w)\) and the module-specific parameters, the installation of the module also has a significant influence on heating. The following changes are made depending on the type of installation or mounting:

- Free-standing mount: Installation factor \( f_E = 2 \)
- Roof installation, back ventilated: Halving the radiated heat output \( Q_S \), i.e. installation factor \( f_E = 1 \). Unlike a freestanding mount, only the top of the array is in the radiation exchange with the environment.
- Roof or facade integration, no rear ventilation: In addition to halving \( Q_S \) \( (f_E = 1) \), there is also heat loss as a result of convection \( Q_K \). In the model, this is achieved by reducing the effective wind speed by 3 m/s.

Determination of the wind speed at system height

The wind speed is determined from the scalar wind speed from the climate data \((V_{w,10m})\), which was measured 10 m from the ground:

\[
v_w = v_{w,10m} \cdot \frac{\ln h_w}{\ln \frac{10 \text{ m}}{Z_0}}
\]

With a roughness length of the generator environment of \( Z_0 = 0.3 \text{ m} \)
4.5 Cabling Losses

In order to calculate cabling losses, the cable resistance $R$ is first calculated from the cable cross-section $A$, the cable length $l$ and the specific resistance of the material:

$$R = \sigma \cdot \frac{l}{A}$$

For copper, the specific resistance $\sigma = 0.0175 \, \Omega \cdot \text{mm}^2/\text{m}$.

With

$$P_R = U_R \cdot I = R \cdot I^2$$

Based on the output, the following applies for the relative dissipation:

$$\frac{P_R}{P} = R \cdot \frac{I}{U}$$
4.6 Evaluation Parameters

The input data to define the evaluation parameters are as follows:

- $E_{in}$ = energy irradiated to the PV array surface
- $E_{PVuse}$ = solar energy generated (AC side) - inverter power consumption
- $E_{Last}$ = electricity requirement of power consumer
- $P_{nom}$ = installed PV array output
- $\eta_{C}$ = efficiency of module at STC

The solar fraction sets the usable photovoltaically generated energy ($E_{PVuse}$) in relation to the load requirement ($E_{Last}$).

Solar fraction = $E_{PVuse} / E_{Last}$

In grid connected operation, not just the energy used to meet the load but also the energy fed into the grid is part of the usable energy. As a result, the solar fraction can be more than 100%.

The specific annual yield is the usable energy ($E_{PVuse}$) in relation to the installed output ($P_{nom}$).

Specific annual yield = $E_{PVuse} / P_{nom}$

Put another way, the specific annual yield is a measure of the PV system's annual full load operation hours. The term final yield is frequently found in the literature in place of the specific annual yield. This is determined from the annual full load hours divided by 365 days and is a measure of the daily full load operation hours.

Performance ratio = $E_{PVuse} / E_{in} \times \eta_{C}$

The performance ratio is a measure of the energy losses in the system which occur in comparison with the energy output of the PV array under standard test conditions. The output under STC is determined by the energy irradiated to the PV array surface ($E_{in}$) multiplied by the module efficiency under STC ($\eta_{C}$). The performance ratio describes the efficiency of the photovoltaic energy which can be potentially generated in a given system environment.

The system efficiency is a measure of the conversion of the total energy irradiated to the array surface ($E_{in}$) by the PV system. The system efficiency is made up of the efficiencies of the PV array and the inverter and takes into account cabling losses and battery losses.

System efficiency = $E_{PVuse} / E_{in}$

2 Standard test conditions: 1000 W/m² vertical radiation, 25 °C module temperature and radiation spectrum AM 1.5
4.7 Economic Efficiency Calculation

The economic efficiency calculation in PV*SOL®, according to the net present value method, is based on the following formulae:

The cash value (CV) of a price-dynamic payment sequence \( Z, Z \cdot r, Z \cdot r^2 \ldots \) over \( T \) years (lifetime) as per VDI 6025 is:

\[
Barwert BW = Z \cdot b(T, q, r)
\]

\[
Barwertfaktor b(T, q, r) = \begin{cases} 
\left(\frac{1 - \frac{r}{q}}{q - r}\right)^T & \text{für } r \neq q \\
\frac{T}{q} & \text{für } r = q
\end{cases}
\]

\( q \): Simple interest factor (e.g. 1.08 at 8 % simple interest)
\( r \): Price change factor (e.g. 1.1 at 10 % price change)

The following applies for the net present value:

Net present value of the total investment = \( \sum \text{Cash of the payment sequences over the lifetime} \) · investment + subsidies

Positive net present values indicate an investment which can be assessed as economically positive. The pay-back time is the period the system must operate for the investment to yield a net present cash value of the overall investment of zero. Pay-back times of over 30 years are not supported. If the CV of the costs is converted into a constant sequence of payment \((r=1)\), then the following applies to this sequence \( Z \):

\( Z = [\text{CV of costs}] \ast a(q, T) \) \text{ with } a(q, T): \text{Annuity factor (} = 1 / b(T, q, r) \text{ for } r=1)\)

The following applies for the electricity production costs:

\([\text{Electricity production costs}] = [\text{annual costs } Z] / [\text{annual electricity generation}]\)
4.8 Design Recommendation

For stand-alone systems in the quick design (for new projects only), PV*SOL calculates a design recommendation based on the Climate data record, the Inclination and Orientation of the modules, and on the Consumption. The result of this design recommendation is the output of the PV modules and the battery capacity.

For the design, PV*SOL requires the energy requirement and the irradiation on one design day. PV*SOL calculates these values from the given climate data record and the consumption of the selected Design month.

The battery is designed so that the energy requirement over the given Period of autonomy can be met entirely from the battery without it being charged.

The PV array is sized so that the number of batteries calculated above are completely charged from the lower discharge threshold within the given System recovery period. The energy requirement and the battery losses must be also be met within this period. In addition to the module orientation, whether or not an MPP tracker is available is also part of the array sizing. Without MPP tracking, it is possible that a 50W module supplies considerably less output at 100W irradiation.
5 PV*SOL® Components

The PV*SOL® components are:

- PV modules
- Inverters for grid connected and stand-alone systems
- Batteries
- MPP trackers
- Load profiles for electrical load
- Electrical appliances
- Climate data for the system site
- Tariffs for energy supplied to and drawn from the grid
- Pollutant mix for electricity from the grid and energy savings.
- Loans

The individual components are defined via the corresponding Menu or the Speed Buttons.
6 Operating Instructions

The programme is operated by using the menus, the symbols on the button bar and the mouse. The parameters on which the calculations are based are set in the appropriate dialog window (see Main Screen).

PV*SOL® is a WINDOWS™ application, and the usual WINDOWS™ features and commands are incorporated as follows:

The formats for numbers, date and currency are as per the settings within the WINDOWS system control panel. If you change the settings in the system control panel you will have to restart PV*SOL® in order to activate the changes within the programme.

All graphics within the programme can be printed out. You are able to change the printer settings from within the programme.

The online Help facility giving information on all PV*SOL® dialog windows and menus is available via the function key F1 or the Help menu. In the Help menu you can search under various headings and key words, and, by clicking on the green colored text, you can go straight to the next link. Or you can simply scan through the individual help texts.

The Variant Comparison table, the tables within the Graphics facility and the Appliances - Load Profile can be copied and pasted into other spreadsheet programmes such as EXCEL.
6.1 User Interface (Menu, Tool Bar, Dialogs)

PV*SOL® is simple to use with the usual menu and tool bar.

Menu commands currently unavailable are shown in gray type. For example, the command Calculations › Simulation is gray as soon as valid simulation results are available.

All dialogs for entering simulation parameters and outputting results are opened via the menu or the speed buttons in the toolbar.

The dialog is closed by clicking on OK, Cancel or Close, by clicking on the WINDOWS button marked with an X in the top right-hand corner of the dialog, or by the key combination ALT+F4.

The dialogs consist of input fields, selection fields ✓, radio button ☐, selection lists ▼ and buttons.

You can use either the mouse or the tab key to move between the fields within a dialog window. With the TAB key you move to the next field and with SHIFT+TAB back to the previous field.

The various values are keyed into the input fields. When the arrow points over an input field it automatically changes to a cursor. With a single click of the left-hand mouse button in the input field you are ready to enter text with the keyboard. By double clicking on the input field the entire text within the field is marked and will be overwritten as soon as you start to type.

The formats for numbering, date and currency are as per the settings within the WINDOWS system control panel. If you change the settings in the system control panel you will have to restart PV*SOL® in order to activate the changes within the programme.

On quitting a dialog window with OK, the programme checks whether valid formats have been used and at the same time tests if the entered values are within reasonable limits.

In addition to the input fields, the programme uses selection fields (check boxes). These are small square or circular fields that are activated or deactivated with a single click of the mouse. If the selection fields are grouped together, only one selection is possible.

By clicking on the buttons in the dialog window you can open further dialogs. The buttons in the right or bottom button bar of a window (eg OK, Cancel, Copy, Close) control the window.

Check boxes ✓ allow selecting of multiple options, radio buttons ☐ allow selecting an option.

At the top of the main screen is a button bar with a number of speed buttons, each with a different icon. These icons represent the menu commands that you will use most frequently when working with the programme. Clicking on the various speed buttons is the quickest and easiest way to get to the most important dialogs.
Each speed button is labelled with its menu title. You just have to position the pointer over the button icon and a label appears with the title.

6.1.1 Menu

The menu is used to open the various dialogs which are used to enter the project parameters.

If you want access the menu commands without using the mouse you can do so by pressing the Alt key and the corresponding underlined letter in the menu command.

File

Conditions

Appliances

System

Calculations

Results

Database

Language

Options

Help

6.1.2 Speed Buttons on the Main Screen

You can also quickly access the most important commands by clicking on the speed buttons in the button bar on the main screen.

These buttons represent those menu commands that you will use most frequently when working with the programme.

Each speed button is labelled with its menu title. You just have to hover the mouse pointer over the button and a hint appears with the title.

New Project

Open...

Save

Technical Data (only systems without 3D visualization)
3D visualization (only systems with 3D visualization)

Climate Data Files

Tariffs

Individual Appliances

Appliances – Load Profile

Shade (only systems without 3D visualization)

Simulation

Economic Efficiency Calculation...

Annual Energy Balance

Energy and Climate Data...

Summary Project Report

Variant Comparison...
6.2 QUICK GUIDE - Editing Projects

In PV*SOL, a PV system is treated as a project.

Menus and dialogs are laid out so that they map the workflow from the left to right and top to bottom:

→ How to simulate a PV system:

1. Create project, with
   a) 2D = without 3D visualization,
   b) 3D visualization or
   c) of a Quick design

2. Set Climate data and other Boundary conditions

3. Planning the PV system
   Set 2D
   Technical data of the system and the PV array
   Define Losses
   Shading in 2D
   Use Check
   Define 3D systems with 3D visualization:
   Terrain, building (roof areas),
   Module coverage or module mounting and module configuration
   ! No more than 2000 modules may be installed in the 3D visualization.

4. Calculations:
   a) Simulation
   or/and
   b) Economic efficiency
calculation

5. Results:

Project report,

Financial analysis:

Annual energy balance

Energy and climate data as graphic evaluation

then

Variant comparison

Last updated: 30.1.2013
6.3 Load and Save File

Projects, components, tariffs and appliance profiles are saved to file or loaded from this dialog.

Each file type has its own format and a set file extension. These are:

- .prj for Projects
- .wbv for climate data
- .emm for the pollutant mix
- .tar for the from grid tariff
- .eta for the to grid tariff
- .slg for loads
- .mod for PV modules
- .wre for inverters (grid connected)
- .wra for inverters (stand-alone)
- .sch for shading
- .vbi for individual appliances
- .mpp for MPP trackers
- .acc for Batteries
- .cre for Loans

From this dialog you can Select files from those available in the list.

When you Open the dialog the directory that has been entered under the Options/Drives menu is displayed. If you want to select another directory as standard, you will have to do this in the Drives dialog.

When a file from the file dialog is selected a description of the file contents appears in the field labelled "File Reference".

You are able to exit the dialog with OK only after you have selected or entered a name in the "File Name" field. Click on the OK button to load the selected project.

When you Save an existing file the project automatically checks if you want to go ahead and overwrite the file.
The load file dialog for Modules and Inverters is different from the other standard dialogs. In addition to the file name, details on the contents of the files, ie manufacturer, type, output and voltage, are displayed. These details can be sorted by heading. Any new order selected will remain unchanged regardless from where the dialog is next opened. If you have already selected a type of module or inverter, this data record will be highlighted in blue.
6.4 Simulation

Starts simulation of the current project with the given parameters. The system is simulated at hourly intervals over a year.

The basis for the calculations can be found in the programme user manual.

The simulation only takes a few seconds, although the exact time depends on the computer being used, the number of arrays in a system and the type of temperature model selected.

After simulation you can select whether you want to run the Economic Efficiency Calculation, or view the Annual Energy Balance, the Summary Project Report, or the Graph of Results.

You are also able to go back to the programme’s main screen and continue work on your project using the menu bar or speed buttons.

All results are now activated in the Results menu and can be viewed. As long as the project parameters remain unchanged you are not able to carry out the Calculations > Simulation command.
7 File Menu

Here you will find all of the commands you will need for organising project files and you can exit the programme via Exit.

New Project
Project Administration...
Open...
Save/Save As...
Exit
7.1 New Project

This dialog window appears automatically when you start up PV*SOL the first time. From here you can start defining a new project.

Proceed as follows:

1. Choose whether you want to simulate a grid connected or a stand-alone PV system (not available with PV*SOL®-N for grid connected systems only).

2. Select a grid concept: full feed in or net metering.

3. Select whether the system is planned in 2D, or whether you wish to use the 3D visualization.

4. By starting the new project with Quick Design, you can plan your system fast and comfortably. The Quick Design is a complete system simulation, using sensible standard values.
   If the Quick Design is displayed as inactive (grey), then the corresponding standards file stndrd1.prx (grid connected) or stndrd2.prx (stand-alone), respectively, is missing in the installation folder /bin, you can copy these files from the project folder (e.g. c:\pvsol\projects\...).

5. Confirm your selection with OK.

6. If you had opened a project already, you are now asked to save it first.

Then PV*SOL Expert displays a background image according to your system.

See also:

Quick Design – Stand-Alone Systems
Quick Design – Grid Connected Systems
7.2 Quick design

The quick design is a complete simulation of the system which uses practical standard values.
7.2.1 Quick design of stand-alone systems

PV*SOL makes a design recommendation on the criteria of low, medium or high solar coverage or on the basis of a selected month.

The program sets the system with one array and direct battery coupling. DC appliances are assumed.

.arrow How to proceed:

1. Select a location with the climate file.
2. Enter the orientation of the PV array.
3. Set the consumption.
4. Define the required Individual appliances by clicking on the Consumption button. Definition using load profiles is not possible in the quick design.
5. Click on the Design button to calculate the required battery capacity and PV output.
6. Select the desired system voltage
7. Enter whether a back-up generator is to be used.
8. Click Sizing. This is where you enter information on achieved output and capacity. If you select batteries or modules which cannot be configured with the system voltage, a warning appears.
9. Save the entered values in the standard file via the Save as default button. The next time a new project is created, the quick design with these settings is opened.
10. Start the simulation with Simulation.
11. Exit the dialog with OK. The modified values are taken over into your current project.
   Click Cancel to restore the state before the file was last opened.
7.2.2 Quick design of grid-connected systems

In the quick design, the system consists of one array and can have several inverters. The energy generated is fed into the grid in full and an appliance is not defined.

Using the system output and after selecting module and inverter types, a recommendation for the number of configuration of the modules and the number of inverters is calculated.

→ How to proceed:

1. Start the quick design via File > New project > "Start new project with quick design" > OK
2. Enter a project name.
3. Click on Climate data to set a location.
4. Click on PV module to select a PV module from the database.
5. Enter the Azimuth and the Inclination of the PV modules.
6. Enter either the Desired system output OR a Set number of modules.
7. Accordingly, click either on Inverter to select one from the database, or on Inverter combinations. Inverter combinations - configuration selection
   7.1 The configuration selection starts with the message "A suitable configuration could not be found", until you have selected a suitable inverter; then it starts with the last selected inverter.
   Confirm by clicking OK.
7.2 Select either a) Select inverter manufacturer or b) Select inverter model.
7.3a) Select the desired Manufacturer from the list. In the window to the right, all suitable inverters from this manufacturer are shown.
   Set the Number of different configurations and inverter types.
7.3b) In the Inverter data area, click on New or Other inverter model to select an inverter with the help of filters.
   The inverter database with the following filters appears:
   - Manufacturer
   - Matching default data
   - In threshold range
   - Not matching
   - Filter according to permissible unbalanced load
   - Show only user-created data records
   - Show products that are not available
   Here, you can also import or export inverter data records.
7.4 As required, you can select the following configuration criteria:
   - Allow wider tolerances (+/- 20%) when checking the sizing factors.
   - Show all possible configurations
   - Filter according to permissible unbalanced load (in relation to total system)
7.5 Possible configurations are shown in the Select module/inverter configuration table. Choose one and then leave the dialog by clicking OK.
8. You see the calculated sizing: installed power, total number of modules, gross PV area and below the selected configuration.

9. All other parameters are filled out with practical standard values alongside the entry parameters in the quick design. If you want to modify these, click on the Technical data dialog.

10. Click on Simulation

11. Following the simulation, you are given a summary of the project report. This one-page report can be printed out. Close the print preview with $\times$.

12. If you want to modify the values in the quick design and repeat the simulation, click on the $\ll$Back button.

Otherwise, leave the quick design by clicking OK. You can add to your system in the program and run the simulation again.
7.3 Project Administration...

In Project Administration you can enter the project name, the project number, the project designer and the location of the PV system.

For easy project identification, these details will appear on any printouts that you make.

From the main screen you can also enter a system variant reference. This appears as a file reference with the project file name.

Whenever you exit a project with the command File/Save As..., the project administration details are saved with the project.

With the command File/Save As... you can therefore save as many versions of a project as you wish, and they are easily recognisable by the comment you enter in the variant reference field.
7.4 Open...

File/Open... opens the Open File dialog, where all projects are listed – ie all files with the file ending *.prj.

Select a file and the system variant reference appears in the file reference field.

Double clicking on the file name, or clicking on the OK button, opens the selected project.

If you are working on a project, and at the same time open another project, a message will appear asking if you want to save any changes made to the project you were originally working on, which will then close to enable you to work on the project you have opened.

The other way to open existing projects is to go to the File menu. At the bottom of the menu is a list of the projects you have previously worked on, the first on the list being the project currently open. Just double click on any of the project file names to open the file.
7.5 Save or Save As...

File/Save saves the current project to the valid file path and name as previously saved. If a project file does not yet exist (ie you are saving a project for the first time), the Save As... dialog appears.

File/Save As... saves the current project under a new name of your choice. The system variant reference is automatically selected as the file reference.

This command is used when you want to design a new project or design a new version of a project.

You should create a separate folder for each project, into which you can then save all the different versions of a project.
7.6 Exit

Go to File/Exit to close the programme.

If you have not yet saved the changes you have made to the current project, a message will appear asking if it should be saved.

If you wish you can change the programme settings, so that the last project you have worked on automatically opens the next time you use PV*SOL (instead of the Quick Design dialog), this is done via Options/Paths.
8 Conditions Menu

Before a simulation can be carried out, the ecological and economic conditions have to be entered or confirmed using the menu commands listed to below.

These details belong to the system, but are dependent on the location.

With the exception of the To Grid Tariff this information is given by loading files from the database (either those delivered with the programme, or any you have defined yourself in the Database).

Climate data files
Pollutant Mix
Tariffs
8.1 **Climate Data Files**

With the *Conditions > Climate data* menu command you open the module MeteoSyn, from which you can load the climate data file for the project location or the site closest to the project location. The files (e.g., London.wbv) contain values over a one year period for global radiation, external temperature and scaled wind speed in hourly format.

Climate data can be viewed in graph format before and after simulation with the menu command *Results > Energy and Climate Data....* Wind data is only evaluated when the “Dynamic Temperature Model” is selected under *Options > Settings > Calculation Model*.

The irradiation onto the (tilted) PV surface, combining diffuse and direct radiation, is generated from global radiation.

The ground reflection (albedo), entered in the *Technical Data > Calculation Model > Losses* dialog, is accounted for as a diffuse radiation gain.

The radiation reflected off the module surface is accounted for as a reflection loss. After simulation you can view this data in diagram format under *Results > Energy and Climate Data....* The details are divided into radiation onto the tilted PV array surface and radiation minus reflection and are shown in W/m².

Reflection losses on the module surface lead to a decrease in the module's efficiency.
8.2 Pollutant Mix

Pollutant Emissions results are loaded from the (Conditions/Pollutant Emissions/)Load file dialog. Here you can choose from a selection of files provided under Pollutant Mix in the database.

If you want to define a new pollutant mix, you can do this via the Database/Pollutant Mix menu. Once saved you can then use the file for future projects.
8.3 Tariffs

This is where you set the tariffs for power supply to and from the grid (Conditions/Tariffs menu).

Clicking on the To Grid Tariff button opens the To Grid Tariff dialog. From here you can define or load a tariff.

Clicking on the From Grid Tariff button opens the Load File dialog and you can then choose from the tariffs provided in the database under From Grid Tariff. To help you choose the correct tariff level, a description of the tariff is given in the file reference field.

In the (Electricity) Tariffs dialog, under Supply Concept, you need to select whether all PV energy produced should be fed into the grid (select Full Supply), or whether the energy requirement of the appliances connected to the system should first be covered (select Own Use).

Even if you select the full supply concept, you are still able to define the appliance load and thereby monitor the overall costs of electricity used by the appliances connected to the system.
9 Appliances Menu

- Prerequisite: Grid connected system with net metering, see menu File > New Project

There are two ways of setting the electricity requirement.

If you are able to give a figure for the total annual energy consumption, you should enter this value in the load profile dialog. If not, you can enter values for a range of individual electrical appliances.

If you use both of the above methods, the programme calculates the total requirement. If, for example, you have entered values in the load profile dialog, the energy requirement is shown when you open the individual appliances dialog, and is then included in the calculation of the total energy requirement.

When designing a stand-alone system you will need to select either AC or DC appliances in the System/Technical Data menu.

Load Profile

Individual Appliances
9.1 Load profile - List of Appliances

Page Consumption > Select Load Profile > Definition of Electrical Appliances by Load Profile

A list of appliances on the left displays names and total annual energy consumption, including the Total annual energy requirement calculated from these and the hourly maximum value. The hourly maximum value is the maximum energy requirement that occurs during an hour of the year.

The New Consumer and Close buttons are located at the bottom right.

Proceed as follows:

1. Click on New Load Profile to create another electrical appliance. Up to four electrical appliances can be defined.
2. Click on the symbol for electrical appliances to open the Electricity consumers dialog for selected consumers. For details, see Load profile - Appliances via load profile.
3. Repeat the process for all relevant consumers. The Total annual energy requirement and the hourly maximum value that you have calculated are displayed in the individual consumers.
4. Exit the dialog by clicking Close.
9.2 **Load Profile - Appliances via Load Profile**

*Page Consumption > Load Profiles: Selection > Definition of electrical Appliances by Load profile > Electrical Appliances by Load Profile*

› Proceed as follows:

1. Click on the icon to open the dialog *Electrical Appliances by Load Profile*.

2. Enter a name.

3. Define the *Electricity Requirement*, i.e., the *Annual Energy Requirement* in kWh, as well as the *Weekend Consumption* for Saturdays and Sundays in % of the weekday requirement.
   
   The *maximum hourly value* is calculated and displayed.

4. Load and edit a consumption profile from the database by clicking on the *Consumption Profiles* button.
   
   The profile name is displayed.

5. Define up to three holiday periods by clicking on the *Holiday Periods* button.
   
   - The dialog "Holiday Periods" opens.
   
   - Enter up to three holiday periods.
   
   - Allocate them electricity requirements as a % of working day consumption.
   
   - Confirm and exit with *OK*.

6. Click on the *Graphic* button to show the consumption profile as a graphic.
   
   - You can modify the layout of the graphic.
   
   - Use *File >* to copy the graphic to the clipboard or to print it out.
   
   - Use *Table*, to export the numerical values of the consumption profile into a spreadsheet:
   
     - Right-click the X-axis and then on *Scaling* (context menu) to set the display interval and the bar width.
   
     - Confirm with *OK*.
   
     The values have now been copied to the clipboard and can be copied into a spreadsheet.

7. Confirm and exit with *OK*.

Or:

1. To delete this appliance, check the box *Delete Appliance* and confirm that you want to delete by clicking *OK*.

**Defining load profiles**

You can create load profiles yourself and modify them in the menu *Databases > Load Profiles*. 
9.2.1 **Holiday Periods**

*Page Consumption > Load Profiles: Selection > Definition of Electrical Appliances by Load profile > Electrical Appliances by Load Profile > Holyday Periods

Proceed as follows:

1. Define up to three holiday periods by clicking on the **Holiday Periods** button. The dialog "Holiday Periods" opens.

2. Enter up to three holiday periods, use the format dd.mm
   If you do not want to enter any holiday periods, enter the same dates in both/all entry fields.

3. Allocate them electricity requirements as a % of working day consumption.

4. Confirm and exit with **OK**.
9.3 List of Individual Appliances

Page Consumption › Individual Appliances: Selection › Definition of Electrical Appliances by Individual Appliances

Consumption of up to individual appliance can be entered.

→ Proceed as follows:

1. Click the button
   - 🔄 New, to create an individual appliance,
   - 📂 Load, to open an individual appliance,
   - ✗ Delete, to remove an individual appliance.

2. The selected individual appliance is displayed on the left.

   ![Toaster Image](image)

   To define the hourly basis and the other properties of an individual appliance, click on the 📂 icon left of the name of the individual appliance in the list. The Individual Appliances dialog window opens.

   → more details refer to: Define an Appliance

3. The total annual energy requirement and the maximum hourly value are calculated and displayed below the individual appliances.
   The maximum hourly value is the highest possible energy requirement of an hour, over a whole year.

4. Exit the dialog with ✗ Close.
9.4  Define an Appliance

Page Consumption > Individual Appliances: Selection > Definition of Electrical Appliances by Individual Appliances > Individual Appliances

Proceed as follows:

1. Click the button Load to open a list of included individual appliances to select one as basis for your own appliance.

2. Enter a name for the individual appliance.

3. Open the list of Types of individual appliance and select one. The different types constitute different operating periods, and therefore different dialog contents are displayed:
   - User-independent appliance (e.g. refrigerator)
   - User-dependent appliance (e.g. television)
   - Short-time use appliance (e.g. coffee machine)
   - Light

4. Enter, if applicable, the Power [W] and the Standby Power [W] and, for user-independent appliances, the Annual Energy Requirement [kWh].

5. Operating hours
   Depending on the choice of Type, further time definition options are shown in the lower part of the dialog window, using which you can define the individual consumption behavior of the appliance:

<table>
<thead>
<tr>
<th>Appliance type</th>
<th>Operating hours - Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>all days the same / Day</td>
</tr>
<tr>
<td>User-independent appliance</td>
<td></td>
</tr>
<tr>
<td>User-dependent appliance</td>
<td>x</td>
</tr>
<tr>
<td>Short-time use appliance</td>
<td>x</td>
</tr>
<tr>
<td>Light</td>
<td>x</td>
</tr>
</tbody>
</table>
### Instruction

Uncheck the option "all days the same" and define individual daily reduction times.

### in Operation:
Click on month field or day field (green)

### Not in Operation: Click on month field or day field (white)

- **User-independent appliance:**
  - appliance runs constantly or appliance runs every X hours/Minutes. The duration is calculated automatically from the annual energy requirement and, if applicable, the Stand-by Input, you have entered.
  - In combination with the months and days in use, the total number of operating days is calculated and displayed.

- **User-dependent appliance:**
  - nighttime only: Operating hours are valid, if simultaneously, the global irradiation is zero.
  - daytime only: Operating hours are valid, if simultaneously, the global irradiation is bigger than zero.
  - in combination with all days the same / Day
  - In combination with the months and days in use, the total number of operating days is calculated and displayed.

- **Short-time use appliance:**
  - Enter the period of use in [min] or energy requirement in [kWh] per use.
  - Enter the number of uses per hour (in combination with all days the same / Day).
  - In combination with the months and days in use, the total number of operating days is calculated and displayed.

- **Light:**
  - in total darkness: The given operating hours are valid, if simultaneously, the global irradiation is zero.
  - at dusk: The given operating hours are valid, if simultaneously, the global irradiation is less than 20 W/m².
  - cloudy weather: The given operating hours are valid, if simultaneously, the global irradiation is less than 50 W/m².
6. Click on **Save** to store your entries.
7. Exit the Dialog with **OK**.
9.4.1 Individual Appliances: User-Independent Appliance

A user-independent appliance is not normally switched on and off by the user, but runs automatically for long periods of time – e.g. refrigerator, deep-freeze.

Stand-by: an entry is not possible in the case of an appliance in constant use.

Annual Energy Requirement: the annual energy requirement should be given for general operation over the whole year.

Operating Times:

- **Appliance in Constant Use:** the appliance is generally switched on the whole time.

- **Switch on Every...:** sets the switching-on interval. Define the appliance by the intervals it remains switched on.
9.4.2 Individual Appliances: User-Dependent Appliance

A user-dependent appliance is used regularly and at certain times, e.g., TV, computer.

Stand-by: an entry here is only made for appliances with this facility where stand-by is always active when the appliance is not in operation.

Operating Times:
Clock: the hours of operation are set by clicking on the fields (green field = in operation, white field = not in operation).

- **All days the same**: if the tick is removed, it is possible to enter different operating times for all the days of the week.
- **No Other Restriction**: the operating times are as defined by the clock.
- **Nights Only**: the operating hours are only valid if, at the same time, global radiation equals zero.
- **Days Only**: the operating hours are only valid if, at the same time, global radiation is greater than zero.

<table>
<thead>
<tr>
<th>in use</th>
<th>click on month or day (green)</th>
</tr>
</thead>
<tbody>
<tr>
<td>out of service</td>
<td>click on month or day (white)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>in use</th>
<th>click on hour field (green)</th>
</tr>
</thead>
<tbody>
<tr>
<td>out of service</td>
<td>click on hour field (white)</td>
</tr>
</tbody>
</table>
9.4.3 🌃 **Individual Appliance: Light**

Page Consumption > Individual Appliances: Selection > Definition of Electrical Appliances by Individual Appliances > Individual Appliances

An appliance is defined as a light when it is switched on depending on the amount of daylight.

Output: Electricity requirement in [kWh]

Stand-by Input: an entry here is only made for appliances with this facility where stand-by is always active when the appliance is not in operation.

Operating Times:

- **All days the same**: if the tick is removed, it is possible to enter different operating times for all the days of the week.

Clock: The hours of operation are set by clicking on the fields (green field = in operation, white field = not in operation). The appliance can only operate within the defined operating hours.

- **No Other Restriction**: the operating times are as defined by the clock.

- **Full Darkness**: the operating hours are only valid if, at the same time, global radiation equals zero.

- **Dusk**: the operating hours are only valid if, at the same time, global radiation is less than 20 W/m².

- **Dull Weather**: the operating hours are only valid if, at the same time, global radiation is less than 50 W/m².
9.4.4 Individual Appliances: Short-Time Use Appliance

A short-time use appliance is a user-dependent appliance that is generally switched on for less than an hour each time it is used, e.g. iron, coffee maker.

Output: Electricity requirement in [kWh] per use

Stand-by: Input: an entry here is only made for appliances with this facility where stand-by is always active when the appliance is not in operation.

Operating Times – per use:
- Enter the period of use or
- enter the electricity requirement per use

Hourly Use:
- Enter the number of uses per hour for each hours of the day in the bar.
- If the tick is removed at "All Days the Same", it is possible to enter hourly use separately for each day of the week.
10 System Menu

-> Precondition: Planning a 2D system

Technical Data
Shade
10.1 Technical Data

System \textgreater Technical Data

3D: PV*SOL Expert opens the 3D Visualization. There you define the terrain, buildings or slopes, cover roofs, mount modules and wire them by using 3D objects. The 3D Visualization has its own help.

2D: The technical data for the system configuration are entered in this dialog, which is made up of a number of worksheets.

-> Preconditions:
   1. Planning a 2D system
   2. The sheets used vary according to the system type (grid connected or stand-alone).

-> Proceed as follows:
   1. On the first page "System", you need to select whether the system uses an inverter system or multiple inverters.
   2. Enter the number of Arrays for both types of system.
      You can enter up to a maximum of six arrays.
      A corresponding number of pages then appear on the bottom of the dialog, so that you can define the parameters for each array separately.
      With a single array the page is labelled "Array". A number of arrays are labelled: "Array 1", "Array 2" etc.
   3. The other pages of the dialog vary depending on the selected system: Grid Connected or Stand-Alone.

      About the buttons located on the right hand side of the dialog:
   4. Losses
   5. System Check
   6. Click on \textit{System Diagram} for displaying a system sketch. This sketch also forms part of the Summary Report.
   7. Following a positive system check, you can start the Simulation.
   8. Close the dialog with \textit{OK}. 


10.1.1 PV Array/Sub-Array

*System > Technical Data > PV Array/Array i*

An array is understood as a PV area with the same module types, the same orientation and installation type, and as applicable the same inverters.
10.1.2 Technical data, stand-alone system (PV*SOL Expert only)

System > Technical data

10.1.2.1 Tab System

PV array operation
Select the operating mode of the stand-alone system:

- **MPP tracking**
- **Direct battery coupling**

No. of MPP trackers
With a PV array with MPP tracking, you must define whether

- one common **System MPP tracker** or
- one **Per array** is used.

Appliances
- Select either **DC** or
- **AC consumptions**.
  For AC consumptions, you must include a stand-alone inverter; the tab **Stand-alone inverter** therefore appears at the bottom edge of the window.

Other tabs for stand-alone systems
PV array, array
Stand-alone inverter
Battery
Charge controller
Back-up generator

› Buttons in the right-hand area:
  - Click on **Losses** to check the influence of losses in the DC cabling.
  - To check the configuration of modules and inverters, click on the **Check** button.
  - **System diagram** shows the print preview of the system schematic also included in the summary report. Each array is summarized as a PV symbol and an inverter symbol.
  - Following a positive **Check** of the system, you can start the Simulation.

› See also:
Technical data, grid connected
10.1.2.2 PV array, stand-alone

System > Technical data > PV array

Stand-alone PV arrays require some different data to grid connected ones.

How to proceed:

1. Give the array a Name.
2. Select a PV module.
   If your desired module is not available, you must first enter it in the PV module database.
   Leave the Load file dialog by clicking OK. The parameters are taken over into the current project.
   The complete data record of the selected modules appears in an information window if the cursor is held over the PV modules button.
3. As required, select the option Create preview of roof layout with Photo Plan.
4. Enter the Installation type: free, with rear ventilation or without rear ventilation.
5. Array output:
   - Specify the number of modules: Enter the Number of modules.
   - Determine output from roof area: The Minimum distance of the rows of modules are calculated in the Roof parameters dialog in order to minimize mutual shading and thus determine the number of modules from the available roof area.
   The resulting output of the array is calculated from the number of modules.
6. Orientation
   With the help of the Orientation, the irradiation onto the horizontal surface is converted into irradiation to the inclined PV area.

For stand-alone systems only:
The DC cabling to the charge controller is the cabling from the string distributor of the PV modules to the charge controller. Standard Cable cross sections are available in the selection drop-down box; it is possible to enter other cross sections.

The cabling losses in the cables of the individual modules to the string distributor can be generally taken into account in the "Calculation model and losses" dialog.

If several cables run in parallel to the charge controller, please add together the cable cross sections of the individual cables.
10.1.2.3 Stand-alone inverter

(stand-alone) System > Technical data > option AC appliances > Stand-alone inverter

→ Requirement:

If AC appliances are selected, there must be a stand-alone inverter which converts the PV DC into AC for them.

→ How to proceed:

1. Load a Stand-alone inverter. The dialog Load file is opened.

2. Select an inverter.
   - If the desired inverter is not available, please enter it via Database > Inverter/For stand-alone systems.
   - Exit the dialog with OK.

3. The following data are displayed:
   - AC power rating, maximum output of power consumers, installed PV output, nominal DC voltage, battery voltage
   - The AC power rating of the inverter should match the maximum output of the appliances
   - The nominal DC voltage should match the battery voltage.
10.1.2.4 Battery

(stand-alone) System  Technical data  Battery

The type and number of batteries are defined on the "Battery" page.

How to proceed:

1. Open a Battery from the database.
   If the desired battery is not available there, it must be entered via the menu Databases  Battery.

2. The Number and Number in series must match the nominal DC voltage of the inverter and the MPP trackers or the module voltages.
   - Enter the Number of batteries.
   - Enter the Number in series.

3. a) System with Back-up generator:
   In Charge condition at simulation start, enter the value 50 %.
   Calculating the suitable start condition is not possible.

4. a) System Without back-up generator:
   Select the option Preliminary simulation to establish start condition (The Charge condition at simulation start is then ignored).
   An initial year is simulated and then December 31 used as the start value for January 1 of the next simulation year.
   This prevents the energy balance of the simulation being displaced by a large deviation in the start value of the battery charge condition after the simulation.
10.1.2.5 Charge Controller

Because of the large number of different designs, there is no database unit for special charge controllers in PV*SOL®.

On the "Charge Controller" sheet an entry is made for the battery's Lower Discharge Threshold.

For your information in regard to charge controller sizing, the short circuit current at 1000 W/m² and 50 C module temperature, and the appliances’ maximum electricity use are shown.
10.1.2.6 Back-up generator

(stand-alone) System ➤ Technical data ➤ Option System with back-up generator ➤ Back-up generator

If you plan a system with a Back-up generator, a corresponding tab appears.

The following data on the system are displayed in summary:
PV output, gross area, active solar surface

⇒ Requirement:
On the System page, the option System with back-up generator is selected.

⇒ How to proceed:
1. Enter the Power rating.
2. Enter the Minimum power output of the intended back-up generator.
   A back-up generator which should always meet consumption in an emergency must be able to supply the maximum power of the appliances (corrected with the battery charger efficiency). The generator modulates between the minimum and maximum power output. With a single-stage generator, the minimum power output is the same as the power rating.
3. Enter the Fuel consumption. This is required to calculate pollutant emissions and for the Economic efficiency calculation.
4. The Maximum power of the appliances and the Total battery capacity are displayed.

   Battery charger
5. Enter the Efficiency of the AC/DC conversion.
6. Enter the Switch on threshold (related to the nominal battery capacity), which may not be lower than the battery's discharge threshold (see page Charge controller).
7. Enter the Switch off threshold (related to the nominal battery capacity) for the battery charging.
8. Enter the Switching on times for battery charging.

The back-up generator always ensures security of supply for the appliance and adherence to the lower battery discharge threshold. Once the back-up generator has turned on due to the battery reaching the lower discharge threshold, it only switches off on reaching the switch off threshold. A condition for this, however, is that the time switch is activated.

! As meeting the requirements of the appliances takes priority, the battery also charges when the generator is supplying too much energy to meet the load on account of its minimal power output.
10.1.3 Technical data, grid connected

System › Technical data › PV Array / Array i

Inverter Concept
In grid connected operation, there are systems which use a central System inverter or systems with one inverter per Array or string and module inverters, i.e. with several inverters.

The system inverter is defined on the System inverter page.

When designing with several inverters, the information on the inverter is part of the Array page.

Arrays
Enter the number of arrays.

The PV output, gross area and active solar surface are calculated and displayed.

PV array or arrays
On the next page(s), the PV array or the arrays are specified

System inverter
Here, select a suitable system inverter.

The following data are displayed:
MPP tracking range, MPP voltages (STC) of the arrays, inverter output, system output

› Buttons in the right-hand area:

- Click on Losses to check the influence of losses in the DC cabling.
- To check the configuration of modules and inverters, click on the Check button.
- System diagram shows the print preview of the system schematic also included in the summary report. Each array is summarized as a PV symbol and an inverter symbol.
- Following a positive Check of the system, you can start the Simulation.

› See also:
Technical data, stand-alone
Technical data
10.1.3.1 System Inverter

System > Technical data > (Inverter concept) One system inverter > System inverter

Requirement:
On the System page, the option System inverter is selected in the inverter concept area.

How to proceed:
1. Select a suitable system inverter.
2. The following data are displayed:

MPP tracking range,
MPP voltages (STC) of the arrays,
Inverter output,
System output
10.1.3.2 PV array, grid connected

*System > Technical data > PV array*

The PV array is specified on this page.

How to proceed:

1. Give the array a *Name*.
2. Select a *PV module*.
   
   If your desired module is not available, you must first enter it in the PV module database. Leave the *Load file* dialog by clicking OK. The parameters are taken over into the current project. The complete data record of the selected modules appears in an information window if the cursor is held over the *PV modules* button.

3. As required, select the option *Create preview of roof layout with Photo Plan*.
4. Enter the *Installation type*: free, with rear ventilation and without rear ventilation.
5. *Array output*:
   - Specify the number of modules: Enter the *Number of modules*.
   - Determine output from roof area: The Minimum distance of the rows of modules are calculated in the *Roof parameters* dialog in order to minimize mutual shading and thus determine the number of modules from the available roof area. The resulting output of the array is calculated from the number of modules.

6. *Orientation*
   With the help of the *Orientation*, the irradiation onto the horizontal surface is converted into irradiation to the inclined PV area.

7. *Inverter*
   Load an *Inverter*.
   The name of the inverter appears on the right. The complete data record of the selected inverter appears in an information window if the cursor is held over the *Inverter* button.
   ! The *Inverter* button and the *Number of inverters* input field cannot be seen under *System inverter*. These entries are made on the *System inverter* page.
   
   - If the option "*Set fixed number of modules in series when selecting inverter*" is selected, only those inverters which fit in series for the given number of modules are displayed.
   - If the option "*Set fixed number of modules in series when selecting inverter*" is not selected, all inverters which fit in any configuration are displayed. After selecting the inverter, a suitable configuration can be selected for the number of modules in series in *Configuration*.

8. Enter the *Number of inverters*.
   The installed inverter output and the MPP tracking range are displayed.

9. *Configuration per Inverter*
a) Inverter with one MPP tracker:

8.  
   1. Enter the *Number of modules in series*.  
      In *Configuration*, all technically possible configurations are shown,  
      taking into account permissible currents and voltages.  
      
      If the option "*Set fixed configuration when selecting inverter*" is selected,  
      all mathematically possible configurations of the modules per inverter are  
      displayed, otherwise only technically relevant configurations will be  
      displayed.

9. b) Inverter with several MPP trackers:

   1. If a multi-string inverter with several independent MPP trackers was  
      selected, the configuration can be entered separately for each MPP tracker  
      in the *Define multi-string configuration* dialog.

→ See also:

The cabling losses in the cables of the individual modules to the string distributor can be  
gen Generally taken into account in *Losses.*
10.1.3.3 Number of inverters

*System > Technical data > Number of inverters*

When setting the number of inverters, the installed module output and the installed inverter output must match.

The following also applies:

Number of modules per inverter = number of modules / Number of inverters

The program only allows symmetrical configurations, the number of modules per inverter must be the same for all strings of an array.

This is checked when you leave the dialog by clicking *OK*.

A possible error message is:

*The number of modules must be a multiple of the number of inverters.*
10.1.3.4 Losses through Feed-in Management

System > Technical data > Losses > Feed-in Management

On the basis of the 2012 EU amendment on maintaining grid stability in order to ensure reactive power balance between the grid and appliances, PV system operators must provide reactive power.

e.g.: Grid operator requires cos φ = 0.9 → The inverter must supply 10% more output: 90% for the previous active power + 10% for the new reactive power

In addition, larger PV systems with > 30 kW must be remotely controllable by the grid operators.

Small PV systems with < 30 kW must be limitable to 70%.

Reactive power feed-in
Enter a displacement factor cos φ between 0.8 and 1.

With a factor < 1, the usable active power of the inverter will be less.

With a cos φ of 0.95, only 95% of the inverter output will be used.
The inverter should therefore be sized 5% larger.

This is taken into account in the System check, where only the active power is entered in the sizing. For identification, cos φ appears after the AC nominal power with a cos φ < 1.
If the inverter is sized too small, the simulation will reveal drops in yield.

Feed-in limitation
Enter a limitation in PV output of between 60 and 100 percent.

Feed-in outputs which exceed this value with their installed PV output will be limited to this percentage in the simulation.

Proceed as follows:
1. Enter a displacement factor cos φ between 0.8 and 1.
2. Select Maximum feed-in
   Enter a limitation in PV output of between 60 and 100 percent.
10.1.4 Roof coverage with Photo Plan

Using Photo Plan, you can create a photorealistic plan of your roof areas.

How to proceed:

1. There are two detailed instructional videos on how to use Photo Plan (see below). It is recommended that you view the introductory video.

2. With just a few entries on the geometry of the roof, it is possible to gain an impression of the future look of the roof areas. You require only a photo of the roof. Photo Plan imports the dimensions for the selected module from PV*SOL Expert.

3. Here you can export the roof with some solar thermal modules as a Photo Plan project, and import it into PV*SOL in order to fit the remaining area with photo-voltaic modules in PV*SOL. Of course, you can also do this in the reverse order.

4. In addition, Velux® skylights and Braas® roof tiles can be included and displayed.

5. The finished photo and number of modules is imported from PV*SOL Expert.

See also:

- Photo Plan - Introductory video: http://valentin-tutorials.s3.amazonaws.com/PhotoPlanTutorials/EN/PhotoPlan_EN_1/PhotoPlan_EN1.html
- Photo Plan - Advanced functionality: http://valentin-tutorials.s3.amazonaws.com/PhotoPlanTutorials/EN/PhotoPlan_EN_2/PhotoPlan_EN2.html

Before

![Before Image](image1)

After

![After Image](image2)
10.1.5 Installation Type

*System › Technical Data › PV Array / Array i › Installation Type*

The installation type influences the heating of the PV modules.

With a "Free-Standing" mount the entire module surface (front and back) exchanges radiation with its environment.

For a roof-top mount "With Ventilation" only the upper module surface is available for radiation exchange, and for roof-top or façade integration "Without Ventilation" this is reduced further. With roof or building integration the output is reduced further by a lack of convection.

High module temperature leads to a drop in module efficiency. Yields for PV systems with free-standing mounting are therefore higher than those for systems with ventilation space which in turn have higher yields than systems without ventilation space.
10.1.6 Roof Parameters

System (2d) > Technical Data > Array > Roof Parameters

The Roof View window is divided into the following sections:

- Toolbar on top
- Tree view on the left
- Roof visualisation on the right
- Input field below
- Messages at the very bottom
10.1.6.1 Roof View - Toolbar

The toolbar contains the buttons listed below. The current cursor position is also displayed under Coordinates, which allows you to find the position of an object point, for example.
The area of the toolbar to the right shows the distance of a selected barred area point or PV area point from the outer borders of the roof area.

Create a New 2D Object
The Create a New 2D Object button opens the New 2D Object dialog. Here you can define new roof areas, barred areas or PV areas.

Copy 2D Object
Once you have selected a barred area or a PV area you can copy this to the clipboard by clicking the Copy 2D Object button (or pressing CTRL+C). You can then paste the copied barred area or PV area into your roof area by right-clicking and selecting the Paste command (or pressing CTRL+V).

Delete 2D Object
Click the Delete 2D Object button (or press the Delete key) to delete selected barred areas, PV areas, modules or module formations.

Delete All PV Areas
Attention! Clicking the Delete All PV Areas button deletes all the PV areas.

Delete All 2D Objects (except roof)
Clicking this button deletes all the 2D objects except for the roof area.

Enlarge view
This button enlarges the view of the roof area.

Reduce view
This button reduces the view of the roof area.

Zoom - Select Best View
Clicking this button sets the optimum zoom factor.
10.1.6.2 Tree view

System (2D) > Technical Data > Array i > Roof Parameters

The tree view gives you an overview of the 2D objects that are used in your PV system.

Left-click on an element in the tree view to select the 2D object.

Right-click on a 2D object in the tree view to open a context menu with all the available commands for the selected 2D object.
10.1.6.3 Roof Mounting

System > Technical Data > (Generator Output) Determine Output from Roof Area > Roof Parameters > Cover Automatically (context menu on roof visualization)

The Roof Mounting visualization shows your current roof project including the PV areas and barred areas.

-> Requirements:

1. In the dialog Technical Data in the area Generator Output select the option Determine Output from Roof Area.

2. Click the button Roof Parameters. The dialog Roof View opens.

-> Proceed as follows:

1. The roof view is displayed. Define barred areas as new 2D objects and borders.
   - You can drag and drop PV areas and barred areas to move them.
   - If a 2D object is selected, its corner points are shown and can be edited in the input field.
   - The compass rose at the top right of the image is available for projects with mounted PV modules. It shows the direction that the roof faces.
2. Click on the roof area and open the context menu via right-mouse click.

3. Select *Cover automatically* or use *Edit PV Area*. The following keyboard shortcuts are available for editing the module formations:
   - **CTRL** + left mouse key: Multiple selection
   - **SHIFT** + left mouse key: Row selection
   - **ALT** + left mouse key: Column selection

4. Zoom in and out in the roof visualization by rolling the (middle) mouse wheel.
10.1.6.4 Messages

The messages area shows you the following information:

1. Type of installation
2. PV generator power
3. Number of modules

You are planning a mounted system!

PV Generator Power: 2.52 kWp
Module Number: 70

Messages about any conflicts in the roof coverage are also displayed here.

1. No conflicts exist.
   
   --- No Error ---

2. A PV area overlaps with a barred area.
   
   Object "Barred Area1" collides with PV area modules "PV Area 1"!

3. At least one module in a PV area is located outside the roof area.
   
   One or more of the PV area modules "PV Area1" are outside of object "Roof"!

4. The modules of various PV areas overlap.
   
   One or more of the PV area modules "PV Area1" collide with one or more of the PV area modules "Copy of PV Area1"!
10.1.6.5 Input Field

The appearance of the input field varies depending on the type of object that is selected in the tree view.

When *Roof View* is selected, an overview of the workflow appears:

1. Enter roof dimensions
2. Define barred areas
3. Create new PV area
4. Cover this PV area with modules.
5. Position PV Area

By selecting *Current Roof* you can rename the roof boundaries that appear in the roof visualisation.

By selecting the roof object (default: *New Roof*) you can edit the coordinates of individual points of the selected object.

You can use the buttons to add or remove points from the selected roof object.

Click the button to open the Edge Distances window.

If you are planning a mounted PV system, you can also enter the roof orientation and the roof angle.
By selecting a barred area object (default: *Barred Area*) you can edit the coordinates of individual points of the selected object.

Under *Enter position* you can enter the position of the entire selected object.

By selecting a PV area object (default: *New PV Area*) you can edit the coordinates of individual points of the selected object.

Click the button to open the *Module Coverage* dialog.
10.1.6.6 Border Distances

System (2D) > Technical Data > Array i > (Generator Output) > Roof Parameter > Context Menu (right-click on roof) > Border Distances

In the Border Distances window you can specify barred areas of a certain width for the borders of your roof.

→ Proceed as follows:

1. In the tree view select the roof area.

2. and in the input field click the Border Distances button.

3. If you want to define equal border distances for all the boundaries of your roof, then select the option For all Borders and enter a number in the edit field on the right-hand side of the window.

4. Otherwise enter individual border distances for each border of the roof in the table on the left side.

5. Close the window with OK.
10.1.6.7 New 2D Object

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter > New 2D Object

The New 2D Object dialog lets you define new 2D objects for your project.

Proceed as follows:

1. Click the button. The dialog "New 2D Object" opens.

2. First, select the object type in the drop-down menu at the top left: Roof Area, Barred Area or PV Area.

3. Then enter a reference name for your new 2D object.

4. Depending on the selected object type, different standard forms and options are available for defining the new 2D object.
New Roof Area

10.1.6.7.1 New Roof Area

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter > New 2D Object > Roof Area

Proceed as follows:

1. Enter a reference name for your new 2D object.
2. Open the window Border Distances where you can specify barred areas for the borders of your roof.
3. Select one of the geometric standard forms:

   - Rectangle
     ![Rectangle Diagram](image)

   - Trapezium
     ![Trapezium Diagram](image)

   - Triangle
     ![Triangle Diagram](image)

4. Enter the form sizes.
5. For simple roof areas without barred areas and border distances:
   Tick the Cover roof to maximum box to give the new roof area a PV area the same size as your roof.
   PV modules will then be added automatically when you click on OK.
6. If necessary, repeat the respective process for Barred areas and the PV area.
7. Close the dialog using OK.
   The roof is visualized accordingly.
10.1.6.7.2  New Barred Area

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter > New 2D Object > Barred Area

-> Requirement:

You have defined the roof area.

-> Proceed as follows:

1. Enter a reference name for your new barred area.
2. Select one of the geometric standard forms:
   - Rectangle
   - Trapezium
   - Triangle
   - Circle
3. Enter the form sizes.
4. Repeat this for PV areas accordingly.
5. Close the dialog using OK.
   The roof is visualized accordingly.
10.1.6.7.3  New PV Area

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter > □ New 2D Object > PV Area

-> Requirement:

1. You have defined the roof area.
2. You have defined necessary barred areas.

-> Proceed as follows:

1. Enter a reference name for your new PV area.
2. Select one of the geometric standard forms:
   - Rectangle
   - Trapezium
   - Triangle
3. Enter the form sizes.
4. Or, if needed select the option "Fit to roof area"
   The new PV area takes the shape and dimensions of the existing roof area.
5. Or, select the option "Based on number of modules":
   The size of the new PV area is determined for a specified module formation.
   - Enter the number of rows and columns in the planned module formation.
   - The resulting power of the module formation is displayed.
6. Tick the Cover roof afterwards box to add PV modules to the new array area automatically after you click on OK.
7. Close the dialog using OK.
   The roof is visualized accordingly.
10.1.6.8 Module Coverage

*System (2D) › Technical Data › Array i › (Generator Output) Roof Parameter › Edit coverage*

- To open the *Module Coverage* dialog: In the *tree view*, select a PV area and click in the *input field* on the *Edit coverage* button. Alternatively you can right-click on a PV area in the *roof visualisation* or open a pop-up menu in the tree view and click on *Edit coverage*.

- The *Module Coverage* dialog lets you specify the column distances and the row distances for the PV modules. The minimum distance for both values is 0.05 m = 5 cm.

- Under *Installation type* you can specify the module orientation (horizontal or vertical).

- The *Calculate Optimum Row Distance* command is only available for mounted PV systems (Installation type: Free-Standing). By finding the optimum row distance you can minimise mutual shading caused by mounted module rows.
10.1.6.8.1 Calculate the Optimum Row Distance

System (3D) > 3D-Visualization > Module Coverage > Calculate Optimum Row Distance
or System (2D) > Technical Data > PV Generator > (Installation Type) Option "Free-Standing", (Generator Output) Option "Determine Output from Roof Area” > Roof Parameters > Treeview "PV Area X” > context menu "Edit PV Area” > Module coverage > Calculate Optimum Row Distance

For mounted PV systems (Installation type: Free-Standing) you can calculate the optimum row distance. This minimises mutual shading between rows of mounted modules.

The suggested clearance is a function of module inclination $\beta$, position of sun $\gamma$ on 21.12. at 12.00 p.m. and the mounting height $h$ of the module.

Proceed as follows:

1. Go to the dialog Roof View > PV Area > context menu Edit PV Area. This opens the dialog Module Coverage.

2. Use the feature Calculate Optimum Row Distance. This opens the Row Distance dialog.

On display:

**Settings:**
- Module Width $b$
- Mounting Height $h$
- Module Inclination $\beta$
- Roof Angle $\beta_1$
- Position of Sun $\gamma$
- Solar Altitude

Valid for day $X$

**Results:**
- Row distance $d$
- Frame Distance $d_1$

Calculated are the following
Projected Module Width

Minimum distance is calculated for azimuth = 0
(Northern Hemisphere: Module Orientation South)
(Southern Hemisphere: Module Orientation North)

3. The results are used for the module coverage automatically on leaving with OK.
10.1.6.9 Workflow

Example for a PV system with ventilation.

1. Specify the size of your roof area. To do this, select the roof area by left-clicking on the roof area in the roof visualisation or select your roof area in the tree view (default: New Roof). You can now specify the size and shape of your roof in the input field.

2. First of all, delete all 2D objects by clicking the *Delete All 2D Objects (except roof)* button. Alternatively you can delete particular 2D objects by clicking the button, for example to obtain a barred area that you require.

3. Specify the barred areas for the borders of your roof area. To do this, select the roof area by clicking on the roof area in the roof visualisation or select your roof area in the tree view (default: New Roof). Now in the input field click on the button and define the required barred areas in the Edge Distances dialog.

4. Now create a new barred area (e.g. skylights and chimney). Your roof might look something like this:

5. To define a PV area that is matched to the roof area, click the *Create a New 2D Object* button to open the New 2D Object dialog.

6. Select *PV Area* in the drop-down menu at the top left.

7. Select the *Fit to roof area* option for the new PV area.

8. Now tick the *Cover roof afterwards* checkbox.
9. Click *OK* and PV modules will automatically be added to the roof area. Now your roof might look something like this:

![](image)

10. Now you can specify the installation type (horizontal or vertical) and the distances between the PV modules in the *Module Coverage* dialog.
10.1.7 Orientation

*System > Technical data > PV Array / Array i > Range Orientation*

The **Azimuth** describes the collector area’s angle of deviation from the south (northern hemisphere) or from the north (southern hemisphere). It is 0° (in the northern hemisphere) when the area is exactly oriented to the lunchtime position (zenith) of the sun.

<table>
<thead>
<tr>
<th>Azimuth</th>
<th>Northern hemisphere</th>
<th>Southern hemisphere</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>180</td>
<td>0</td>
</tr>
<tr>
<td>East</td>
<td>-90</td>
<td>90</td>
</tr>
<tr>
<td>South</td>
<td>0</td>
<td>180</td>
</tr>
<tr>
<td>West</td>
<td>90</td>
<td>-90</td>
</tr>
</tbody>
</table>

PV*SOL* detects whether the system is in the northern or southern hemisphere from the climate data record, which includes the degree of latitude.

The Tilt angle (inclination) describes the angle between the horizontal and the module surface. It is 0° when the modules lie flat on the ground and 90° when they stand vertically.

The radiation processor calculates the irradiation to the tilted surface from the inclination and orientation.

›› How to proceed:

1. Select from
   - **Fixed inclination**
   - **Single axis tracking**: Enter a tilt angle. The azimuth automatically tracks the sun.
   - **Dual axis tracking**: The module is rotated at all times so that the solar radiation strikes the module vertically.

2. If applicable, enter the orientation and tilt angle.
   The resulting annual irradiation, taking shading into account, is shown in *Irradiation*.

3. Click on *Graphic* to see the irradiation [kWh/m²] over the course of a year and the radiation annual duration curve [W/²].
4. [for grid connected PV arrays only] Click on *Tilt angle with maximum irradiation* to calculate the maximum annual irradiation to the module surface.
   - This corresponds to the optimal tilt angle for Grid connected systems with full feed-in.
   - For Stand-alone systems, the optimal tilt angle in winter must usually be selected.
   Optimizing for the maximum irradiation would result in high and unused surpluses in summer.
   This button is therefore not shown for stand-alone systems.
   The value appears on the button.

5. [for grid connected PV arrays only] Transfer it manually to the input field.
10.1.8 Losses

10.1.8.1 Losses at the PV Generator

*System > Technical Data > Losses > Array i*

The array's power output (DC side) is, along with the STC efficiency and the calculated output, determined by the part load operation, the output's temperature dependency (see output coefficient in the PV Module dialog) and the additional losses.

› Proceed as follows:

1. Enter the following losses, which occur during real system operation:
   - Deviation from Standard Spectrum AM 1.5:
     Spectral mismatch changes the module's characteristic curve, which is measured against a standard spectrum. In Central Europe a correction factor of an annual average of 2% can be allowed for. The correction factor should be entered in the field provided.
   - due to Mismatch or Lesser Yield Due to Deviation from Manufacturers Info:
     Despite equal irradiation and temperature, different MPPs (mismatching) can occur because of production tolerances, or because the modules do not reach their full power as stated by the manufacturer (lesser yield). These kind of power losses can reach 1-5%. (This does not mean the "mismatch effect" that occurs if differently aligned modules, ie a number of arrays, are connected to a single system inverter. These losses are defined during simulation.)
   - in Diodes:
     Losses caused by a drop in voltage by the modules' blocking diodes can usually be ignored.
   - due to Pollution:
     Over a certain tilt angle (approx. 20%) losses caused by pollution can be ignored.

2. Irradiation Gains:
   - Ground Reflection (albedo) is evaluated in the radiation processor. PV array irradiation is increased by the reflection of radiation on the ground or in the surrounding area. With a ground covering of snow the albedo is 80%, under normal conditions the albedo is 20%.
     Enter the average annual ground reflection (albedo).
   - Or enter the monthly albedo.

3. From the system height above ground level it is possible to determine the scalar wind at system height for the dynamic Temperature Model. The wind in the climate data is measured at a height of 10 meters.
   Enter the height of the PV system above ground.
4. Allowing for Manufacturer Tolerances in Pre-Graded Sub-Arrays:
   - Enter the deviation of module output from power rating specified by the manufacturer. This makes sense when you have pre-sorted the modules according to power output.
   - The resulting Module Output is displayed.

5. Direct Current Cabling to Inverter means the cable from the string distributor to the entry of the inverter.
   - Enter the single length of the direct current cables to the inverter.
   - Select a String Cable Cross Section or enter a different cable cross section in mm².
     The sum of the cable cross sections of all strings is displayed.

**Adopt entries for all arrays**

- Requirement:
  More than one array is defined in the System > Technical data > PV generator dialog.
- How to proceed:
  The button "Use for all arrays" at the bottom of the Losses dialog.
  Click on this button to copy all values entered in the active tab into all the other arrays.
10.1.8.2 Losses through Feed-in Management

System > Technical data > Losses > Feed-in Management

On the basis of the 2012 EU amendment on maintaining grid stability in order to ensure reactive power balance between the grid and appliances, PV system operators must provide reactive power.

e.g.: Grid operator requires $\cos \varphi = 0.9$ -> The inverter must supply 10% more output: 90%

for the previous active power + 10% for the new reactive power

In addition, larger PV systems with $>30$ kW must be remotely controllable by the grid operators.

Small PV systems with $<30$ kW must be limitable to 70%.

**Reactive power feed-in**

Enter a displacement factor $\cos \varphi$ between 0.8 and 1.

With a factor $<1$, the usable active power of the inverter will be less.

With a $\cos \varphi$ of 0.95, only 95%
The inverter should therefore be sized 5% larger.

This is taken into account in the System check, where only the active power is entered in the sizing. For identification, $\cos \varphi$ appears after the AC nominal power with a $\cos \varphi <1$.

If the inverter is sized too small, the simulation will reveal drops in yield.

**Feed-in limitation**

Enter a limitation in PV output of between 60 and 100 percent.

Feed-in outputs which exceed this value with their installed PV output will be limited to this percentage in the simulation.

Proceed as follows:

1. Enter a displacement factor $\cos \varphi$ between 0.8 and 1.
2. Select \( \checkmark \) *Maximum feed-in*
   Enter a limitation in PV output of between 60 and 100 percent.
**10.1.9 System Check**

In order to check the interconnection of modules and inverters or MPP trackers and batteries, and the influence of losses in the direct current cabling, click on the System Check button before exiting the Technical Data dialog. Depending on the system connections the system check takes place on one or a number of pages.

If new Settings for temperature and irradiation maximums have been entered under Options/Settings, you will be reminded of this by a message at the base of the window.

**No Discrepancies**

You should only exit the "Technical Data" dialog when, after the system check, the following message appears:

*On checking the system no discrepancies have been found!*

**Further Calculation Possible**

If discrepancies appear, but a simulation of the system is still possible, the following message appears:

*Please check the system parameters! Further calculation possible.*

**Incorrect Database Data**

The system check requires that module and inverter data is saved in the database. If specifications are missing, or if the specifications are not physically possible, a message appears:

*The database files contain incorrect values!*

**Select Components**

If you go to the system check before loading the module and inverter specifications, this message appears:

*Please select components from the database files available!*

**Check System Parameters**

If during the system check errors are found that have to be corrected before simulation can take place, the message is:

*Simulation is not possible until you have checked and corrected the system parameters!*

The following checks occur for grid connected systems:

**Output checks**

The inverter’s nominal output and maximum PV output are compared with the installed PV output per inverter. The inverter’s capacity is defined from the PV output divided by the inverter’s nominal output. A message appears if the capacity is less than 90% or more than 110%. Capacities less than 20% and more than 300% are not accepted.
If the PV output is larger than the inverter’s nominal output, the inverter must reduce the output to the inverter’s nominal output. If the PV output is significantly less than the inverter’s nominal output, the inverter works at a low efficiency rate.

**MPP Voltage Check**
The inverter’s MPP tracking field is compared with the MPP voltages of the modules connected in series. The voltage decreases with rising temperature and decreasing radiation.

Boundary values in defining the MPP voltages that occur in the PV system are:

- a working point for high irradiation and low temperature to define the maximum MPP voltage, and
- a working point for low irradiation (onto the tilted module surface) and maximum module temperature to calculate the minimum MPP voltage.

The working points are dependent on the:

- location of the system,
- orientation and inclination of the modules, and the
- type of module mount.

PV*SOL® takes the lowest module temperature as being equal to the lowest external temperature in the climate data record being used. Maximum radiation is taken from the climate data record for the month in which this temperature occurs, for the preceding month, and for the following month, and is converted onto the tilted module surface. For example, with an orientation due south and a 30° inclination, the values for two different locations are:

- Berlin: 14 C und 858 W/m²
- Freiburg: 11 C und 957 W/m²

To define the system’s lowest MPP voltage, the value of the irradiation during module part load performance is taken from the module database as the minimum irradiation. For example: 300 W/m².

The maximum module temperature for this irradiation is defined by the maximum temperature at the system location plus an offset. The maximum system location temperature is read from the climate data record being used. The offset is dependent on the module mount and the irradiation.

It applies that:

$$T_{\text{max, Modules}} = T_{\text{max, Sys. Location}} + \text{factor} \cdot \frac{G_{\text{min}}}{1000}.$$  

Factor = 20 for free-standing modules,  
Factor = 30 for rooftop mounting with ventilation space, and
Factor = 45 for roof or façade-integrated modules without ventilation space

This gives, for example, an offset of +9°C on the external temperature for modules with ventilation space, and a minimum irradiation of 300 W/m².

If under Options/Settings/System Check you select Set Values, you can enter temperature and irradiation extremes, which are then used in the system check.

The module array’s MPP voltage is calculated for both of the working points described above, and then compared with the inverter’s MPP tracking range.

A message warning of discrepancies appears if the inverter's threshold values vary by more or less than 10% from the modules. A value over 50% less than the lower MPP threshold is not permitted.

Overstepping the upper MPP threshold is restricted at the next stage by the strict observation of the maximum no-load voltage.

**Upper Voltage Threshold Check**

The inverter’s maximum system voltage must not be exceeded on any account. Exceeding the inverter’s upper voltage threshold can cause irreparable damage to the inverter.

The maximum occurring voltages should be checked very carefully.

As a comparative value PV*SOL® defines the module array’s no-load voltage at the working point: minimum module temperature and maximum irradiation. This point has already been calculated for the MPP voltage check (see: MPP Voltage Check).

A message that the critical voltage has been reached appears if the module array's no-load voltage equals the maximum inverter voltage.

You are able to continue with simulation, but you should take into account when planning your system, that exceeding the maximum inverter voltage can cause irreparable damage to the inverter.

Exceeding the maximum voltage by 25% is not permitted.

The following checks are made on stand-alone systems:

**Stand-Alone System Inverter AC Output Check**

For AC appliances the inverter’s nominal AC output and the appliances’ maximum output are compared to ensure that the inverter can deliver the maximum output for the appliances.

Without a back-up generator, a message appears if the inverter output is less than 98% or greater than 120% of the appliances’ maximum output. Outputs less than 33% and greater than 500% of the appliances’ maximum output are not accepted.

If a back-up generator is used, this is able to cover the consumption directly, ie the back-up generator’s energy does not flow through the stand-alone system inverter. The upper threshold remains the same, but the programme does not strictly set the lower threshold.
**Stand-Alone System Inverter Voltage Check**
For the AC appliances, the battery voltage is compared with the inverter voltage. Both components are loaded from the database and have to be checked against the system voltage.

**Battery Voltage Check**
If your system has direct battery connection, the battery voltage sets the modules’ working point. The battery voltage is dependent on the charge condition. PV*SOL® works with a characteristic curve for the (averaged) voltage.

These benchmark figures are compared with two working points for the modules’ MPP voltage, i.e., the MPP voltage at 500 W/m² and 25°C, and at 1000 W/m² and 25°C (STC). A message appears if the minimum battery voltage is less than 60% and the maximum battery voltage is larger than the corresponding MPP voltage.

Simulation is blocked if the minimum battery voltage is less than 40% and the maximum greater than 110% of the corresponding MPP voltage.

**MPP Tracker Output Check**
If an MPP tracker is used, a check is required to see if the MPP tracker’s output corresponds to the PV output. If the figure is exceeded the PV energy produced will be reduced, if the figure is not reached the MPP tracker works at a poor efficiency rate.

A message appears if the MPP tracker’s output is less than 90% and more than 120% of the PV output. MPP tracker outputs less than 33% and more than 500% of the PV output are not accepted.

**MPP Voltage Check**
The MPP tracker’s MPP tracking range is compared with the module array’s MPP voltages. The voltage decreases with increasing temperature and decreasing radiation. The definition of the working points is as described in the grid connected system check.

For both of these working points the module array’s MPP voltage is calculated and compared with the MPP tracker’s MPP tracking range.

A message warning of discrepancies appears if the MPP tracker’s threshold values vary by more or less than 10% from the modules. Not reaching the lower MPP threshold of around 50% or exceeding the upper MPP threshold of around 25% is not permitted.

Cabling checks are made on both types of systems, and on each PV array.

**DC Cabling Check**
The flow of current through the cabling under standard test conditions (STC) is defined by the module current flow under STC and the number of parallel-connected modules in an array. This should not be more than the permitted electrical capacity of the cabling.
In the programme, the maximum capacity for group 3 insulated copper wiring is based on the Federation of German Electricians' regulations. Relative cabling losses are calculated from the cabling resistance, electricity and voltage under standard test conditions.

Cabling losses of above 20% are not accepted and PV*SOL® produces a message when these are above 5%.
10.1.10 System Diagram

The system diagram shows the print preview of the system schematic, also contained in the summary report.

System components such as arrays, inverters, batteries, and also the consumption as well as the grid concept are illustrated as symbols. Important details, such as the number and type of modules or inverters, are also shown.

The system diagram is a sketch. It cannot be edited and does not represent a full technical drawing of the system.
10.2 Shade

Menu System > Shading

- Precondition: Planning a 2D system

The resulting shade reduces the irradiation to the collector surface area.

Entry of the shade parameters in the programme is in two stages. You are able to define the horizon and middle-distance objects.

Middle-distance objects fully shade the PV generator at certain times of the day.

In order to edit the horizon or objects which are relevant for the shading of your collectors, you must have made a note of the prominent points of the horizon line from your solar system. This can be done with a compass and protractor, with a sun path indicator, a Solmetric Suneye, or with a digital camera and editing software.

10.2.1 Shading: Horizon

A horizon point consists of the azimuth, i.e. the angle has measured from the horizontal and the respective height, i.e. the elevation angle, also measured in angle degrees.

- For definition of the azimuth refer to: Orientation

- Define a new horizon

a) by drawing with the mouse:

1. Start by clicking on the horizon line with the left mouse button. The current position of the cursor can be seen in the upper bar, given as Azimuth : Height.
   A dashed line is drawn between the starting point and the current position.

2. Click the next point using the left mouse button, thus confirming the dashed line.
   The horizon line can only go from left to right. As a result, no dashed line can be seen if you move the cursor left of the (current) end point.

3. Stop drawing by clicking the right mouse button.

4. Redrawing lines can only be done after completing the current sketch point and from an already defined point. The following text is displayed in the upper bar:
   To amend the horizon, click with the left mouse button exactly on the horizon line.

   It can be difficult to click on the existing horizon line where this is vertical. Rather enter a fitting individual object.

5. You can delete the horizon at any time by clicking the New Sketch button.

6. Save this horizon and it's objects for further use in other projects.
b) or by entering table values or by importing a complete horizon:
1. Enter the vertices of the horizon in the table directly. The start and end point are already entered, as are any generated with the mouse.
2. Define a point in the edit boxes first.
3. Add the point to the table using New Point. On being entered, the point appears in the sketch.
4. You can copy the table to the clipboard and from there into spreadsheets such as Excel.
5. You can paste a table from the clipboard.
6. You can remove the selected point (blue background) by clicking Delete Point.

c) or by importing a complete horizon:
1. Import horizon lines created with the horizON software or with a Solmetric Suneye by clicking . When importing files, remove any spurious sky objects to avoid unwanted tall objects on the far horizon.
To print out the shade diagram, you must copy the activated dialog to the clipboard with the key combination ALT+PRINT and paste it into a word processing program such as Microsoft Word via the menu Edit > Paste.

See also: Shade from Individual Objects
10.2.2 Shading: Individual Objects

Menu System > Shading > List of Objects

On the List of Objects page, you define shading from individual objects.

The objects you have defined can be found in the List of All Objects drop-down box. Here, you can select the object whose value you can see or wish to change in the right part of the window.

In addition to the object description in the left part of the window, you can see an image corresponding to the object type (tree or building). If no object has been defined, the list is empty.

How to define a new object:

1. Depending on the object type, click on the New Object - Building or New Object - Tree button. A new object (e.g. with reference Object No. 1) is created and its standard values entered in the right part of the window.

2. To better differentiate among objects, give each object its own reference.

3. Enter the values (for objects in the medium distance): height, width, distance, and azimuth. The measuring point for defining these values is the center of the collector surface looking south. In other words, an azimuth of 0° means that the object is in the south (-90° = East; +90° = West), irrespective of the collector azimuth. The height angle can be defined from the information on height and distance. Width and azimuth set the angle for the vertices of the object. The calculated dimensions (fields with grey background) are calculated on leaving the object.

4. The difference between tree and building resides in the light permeability of the objects. For a tree object, the Seasonal Shade button is activated. Enter a percentage of shade for every month of the year. In summer, shade will be greater than in winter due to leaves.

5. On the Shade page, the building objects appear as red-hatched rectangles, the tree objects as green-hatched rectangles. Double-click on one of the objects to select it on the List of Objects page and modify it.

6. Existing objects can be deleted by clicking the Delete Object button.
11 Calculations Menu

If the system parameters have been defined and climate data has been selected, the programme is able to carry out a simulation of energy yields. After that an economic efficiency calculation is possible, once you have entered tariffs for energy supply to and from the grid.

The Simulation command cannot be accessed (the lettering is grey not black) when valid results are available (ie a simulation has already been carried out and the parameters remain unchanged). The Economic Efficiency Calculation command cannot be accessed when there are no valid simulation results available.

→ See also:

Quick Design
11.1 Inverter combinations - configuration selection

The Inverter combinations dialog is opened in the quick design of 2D systems and the configuration of systems with 3D visualization:

-> How to proceed:

1. Click on Inverter combinations The dialog Configuration selection is opened.

2. The configuration selection starts with the message "A suitable configuration could not be found",
   until you have selected a suitable inverter, when it then starts with the last selected inverter.
   Confirm by clicking OK.

3. Select either a) Select inverter manufacturer or b) Select inverter model.
   3a) Select the desired Manufacturer from the list. In the window to the right, all suitable inverters from this manufacturer are shown.
      Set the Number of different configurations and inverter types.
   3b) In the Inverter data area, click on New or Other inverter model to select an inverter with the help of filters.
      The inverter database with the following filters appears:
      - Manufacturer
      - Matching default data
      - In threshold range
      - Not matching
      - Filter according to permissible unbalanced load
      - Show only user-created data records
      - Show products that are not available
      Here, you can also import or export inverter data records.

4. As required, you can select the following configuration criteria:
   - Allow wider tolerances (+/- 20 %) when checking sizing factors.
   - Show all possible configurations
   - Filter According to permissible unbalanced load (in relation to total system)

5. Possible configurations appear in the table Select module/inverter configuration. Choose one and then leave the dialog by clicking OK.
11.2 Simulation

Starts simulation of the current project with the given parameters. The system is simulated at hourly intervals over a year.

The basis for the calculations can be found in the programme user manual.

The simulation only takes a few seconds, although the exact time depends on the computer being used, the number of arrays in a system and the type of temperature model selected.

After simulation you can select whether you want to run the Economic Efficiency Calculation, or view the Annual Energy Balance, the Summary Project Report, or the Graph of Results.

You are also able to go back to the programme’s main screen and continue work on your project using the menu bar or speed buttons.

All results are now activated in the Results menu and can be viewed. As long as the project parameters remain unchanged you are not able to carry out the Calculations > Simulation command.
11.3 Economic Efficiency Calculation...

After simulation it is possible to carry out an Economic Efficiency Calculation. The Economic Efficiency Calculation follows the net present value method. The entry dialogs and the dimensions calculated are different for stand-alone and grid connected systems.

Economic Efficiency Calculation – Grid Connected Systems
Economic Efficiency Calculation – Stand-Alone Systems
11.3.1 Economic Efficiency: Grid Connected Systems

You are able to move through the Economic Efficiency Calculation in two ways:

- With the Continue and Back buttons at the bottom of the window, you can go to
  the next or the previous page.
- With the left-hand Navigation Bar you can jump straight to the required page.

Every window contains a Help button (in the top right corner) which gives help in respect
of the required entry parameters.
11.3.1.1 Technical Input

(grid-connected system) Calculation > Economic Efficiency Calculation > Technical Input

This dialog shows the basic parameters in PV*SOL which are relevant for the Economic Efficiency Calculation.

-> How to proceed in Germany:

1. **Economic Efficiency Variant**: Name your system.
2. **Start Date**: Enter the system operation start date, it is required for the proportionate allowance for lodgements and disbursements made in the first year.
3. If you let the option *British / Italian Feed-in Tariff* empty, then the German EEG is used for calculations.
   The following technical data are displayed:
   - Peak PV power,
   - PV electricity generated in first year,
   - *Conserved electricity (in first year)*
   - Electricity to grid (in first year)
4. Enter the *percentage of the PV electricity legally compensated*. (EEG 2012: in Germany: 80%; other countries (until further notice): 100%)
   The corresponding data are calculated and displayed:
   - Maximum compensated electricity fed into the grid
   - Unpaid electricity fed into the grid
5. Calculate savings: Choose either:
   - **Calculate Savings from Reference Tariff**, then you can *load* a Household Tariff. The corresponding saving is displayed in €/kWh, or
   - **Set Predetermined Savings**, then you enter a value in €/kWh.
6. Calculate payment: Choose either:
   - **Calculate Payment from Feed-in Tariff**, then you can *load* a Feed-in Tariff. The corresponding payment is displayed in €/kWh, or
   - **Set Feed-in Payment**, then you enter a value in €/kWh.
7. **Market value of unpaid electricity fed into the grid**: Enter the payment you can achieve. (No legal regulation)
8. Continue to the next page to set the **General Parameters** or **Close** the economic efficiency calculation.

-> How to proceed in Great Britain or Italy:

1. **Economic Efficiency Variant**: Name your system.
2. **Start Date**: Enter the system operation start date, it is required for the proportionate allowance for lodgements and disbursements made in the first year.
3. Select the option *British / Italian Feed-in Tariff*. The following technical data are displayed:
   - Peak PV power,
   - PV electricity generated in first year,
   - Conserved electricity (in first year)
   - Electricity to grid (in first year)

4. Enter the following data:
   - Income from PV generation with inflation
   - Period of validity for Tariff
   - Income from Export to Utility Grid with inflation
   - Outgoing Cost of Energy from Utility Grid with inflation

5. Continue to the next page to set the *General Parameters* or *Close* the economic efficiency calculation.

**Glossary**

**Peak PV Power:**
   The output of the system defined in PV*SOL under Standard Test Conditions.
   (STC: 25°C module temperature, sunlight spectrum of AM 1.5 and 1000 W/m² irradiation.)

**PV Electricity Supplied to Grid in First Year:**
   This specifies the amount of electricity fed into the grid in a whole year. The month that the system started operation and degradation are not allowed for here.

**Electricity Costs Saved in First Year:**
   This specifies the cost saving made on electricity drawn from the grid in a whole year. The month that the system started operation and degradation are not allowed for here.

**Use Tariff to Calculate Income from PV Generation:**
   For the Payment Received for Grid Supply the following rule applies: the amount shown is paid, for example, for 20 full years plus the months in the first year of operation.
11.3.1.2 General Parameters

Assessment Period:
Only complete years, not including the year in which the system starts operation, should be entered for the Assessment Period.

According to German standard VDI 6025, the Assessment Period is the time period of planning base for the calculation of economic efficiency (planning horizon).

The Assessment Period should be based on the investment with the shortest Service Life.

If the Service Life of an investment is less than the Assessment Period, the investment will have to be repurchased.

If the Service Life of an investment is greater than the Assessment Period, the investment will have a residual value at the end of the Assessment Period, which is included in the capital value calculation.

Interest on Capital:
The Interest on Capital can be entered as the Rotating Internal Rate of Return. The Rotating Internal Rate of Return is the average yield from fixed interest bonds. The German Federal Bank determines this from the average yields on outstanding debt securities. The Rotating Internal Rate of Return is therefore a measure of the interest level on the bond market.

Value Added Sales Tax
This entry field does not influence the calculation, but is there to make clear that all amounts should be entered either with or without sales tax. As a rule, all amounts should be entered as net sums. However, if you enter a gross amount, you should make sure that all entries are gross.
11.3.1.2.1 Define Output Losses

Calculation > Economic Efficiency Calculation > Technical Input > System output reduction due to age (degradation)

Here you are able to define power loss in the PV modules caused by ageing.

Enter the annual Output Losses as a percentage of the nominal output (power rating). In the Remaining Output column you will then see the resulting output as a percentage of the nominal output. The Output Losses defined first take effect at the end of a period, i.e., losses for the first year first come into effect in the second year, etc. After 10 years, the power output of the PV module remains constant.

If you wish to allow for deviation in the first year of the PV modules’ actual output from the nominal output, then enter this figure in the field labelled Deviation of Module Output from Nominal Output.
11.3.1.3 Income and Expenditure

On the Balance of Costs page you are able to enter all payments divided into cost groups.

The programme recognizes the following cost groups:

- Tax deductible investments
- Non-tax deductible outgoing cost of system setup parts and labor
- Incoming subsidies
- Outgoing annual operating costs
- Consumption costs
- Outgoing other annual costs
- Incoming other income/savings

If you want to enter a number of positions within a cost group, select the Detailed Entry for the cost group. This will automatically take you to the corresponding page, where you can enter as many positions for the cost group as you wish.

If you have selected the Detailed Entry on the Balance of Costs page, the field text is grey and the total of payments for the cost group is shown.

For each cost group you can choose to make absolute or specific entries, but this option is not available if the Detailed Entry selection has been made.
11.3.1.3.1 Investment Costs

Click on Add Position to add a new position to the list.

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then click on Delete Position.

The Inflation indicates the average percentage change of a payment in comparison with the previous year.

The Service Life is the time period measured in years of the economic use of an investment object.

If the Service Life of an investment is less than the Assessment Period, the investment will have to be repurchased.

The price of repurchase is based on the Price Change Factor given.

If the Service Life of an investment is greater than the Assessment Period, the investment will have a residual value at the end of the Assessment Period, which is included in the net present value calculation.
11.3.1.3.2 Non-tax deductible Outgoing cost of system setup parts and labor

On this page you can define Non-tax deductible Outgoing cost of system setup parts and labor, arising at the time the system starts operation, and Savings.

Click on Add Position to add a new position to the list.

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then click on Delete Position.

One-off Payments are (unlike investments) costs which cannot be written-off against tax. They are taxed directly.
11.3.1.3.3 Other Costs

On this page you are able to define any Other Annual Costs.

Click on Add Position to add a new position to the list.

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then click on Delete Position.

The Inflation indicates the average percentage change of a payment in comparison with the previous year.
Click on Add Position to add a new position to the list.

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then click on Delete Position.

The Inflation indicates the average percentage change of a payment in comparison with the previous year.
Consumption Costs

Here you can define the Consumption Costs.

Click on Add Position to add a new position to the list.

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then click on Delete Position.

The Inflation indicates the average percentage change of a payment in comparison with the previous year.
11.3.1.3.6 Subsidies

On this page you can define one-off Subsidies received at the start of system operation.

Click on Add Position to add a new position to the list.

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then click on Delete Position.

Subsidies reduce the costs. They do not influence tax depreciation, but are taxed directly.
11.3.1.4 Financing

Number of Loans
Here you can enter the number of loans that you want to define. You can account for 0-3 loans.

Reference
Here you can give the loan a name, which will then appear in the Project Report.

Loan Capital
The amount of credit, with the calculation based on interest and repayment. The loan amount can be entered as an absolute figure in euros or as a percentage of the investment volume. Investment Volume is understood here as the investments plus one-off payments less subsidies.

Payment Instalment as a percentage of the loan capital (Discount)
This value specifies which percentage amount of the loan capital entered is actually paid.

The loan amount paid is based on the loan capital multiplied by the disbursement rate.

The Total Disbursements for all loans should not be greater than the Investment Volume defined above.

You will also need to define whether the loan is an Instalment Loan or an Annuity Loan.

Instalment Loan
With this kind of loan, repayments are made in equal instalments. The amount of interest to be paid is recalculated after each instalment from the remaining amount of debt. The total repayment amount is calculated from repayments which remain constant and interest on an amount which reduces over the period.

Annuity Loan
With this kind of loan, repayments are made in equal instalments over the repayment period. The loan repayment amount as a percentage of the instalment increases with the number of instalments, while the interest percentage sinks correspondingly.

Period
The loan-repayment period.

Loan Interest
Nominal Interest Rate to be paid on the remaining debt.

Repayment-Free Initial Years
During this period no repayments, but only interest payments are made. In the remaining time up to the end of the period, the loan capital is repaid in instalments.

Repayment Interval
Interest and instalments are paid at these intervals.
11.3.1.5 Tax

In order for tax payments to be included in the Economic Efficiency Calculation, you will need to select the Allow for Tax field.

It is usually the case that with a profitable investment the inclusion of tax payments has a negative impact on the results. The results only improve with changing tax rates. A change in tax rate is possible, for example, if the investor retires after 10 years. If, at the time that the system starts to enter the profit zone, the investor is making losses on other investments, the tax rate could also be set at zero.

Marginal Tax Rate for Income/Corporation Tax:

This is the tax rate that needs to be paid for each additional taxable Euro. The amount should also appear in your tax assessment.

If Allow for Change in Marginal Tax Rate is selected, the New Tax Rate given in Change of Tax Rate comes into the calculation.

Depreciation Period:

The period over which the investment can be written-off against tax. The usual period for photovoltaic systems is 20 years.

Depreciation Type:

Linear (straight line):

Annual depreciation is calculated from the investment amount divided by the depreciation period.

Degressive (reducing balance):

Annual depreciation is not constant, but is calculated as follows:

Investments that have not yet been depreciated are multiplied with the rate of depreciation. This leads to a year by year decrease in the annual depreciation. If the annual depreciation sinks below the value that is obtained through linear depreciation, the residual value is calculated as linear depreciation for the remaining period.
11.3.1.6 Economic Efficiency Calculation - Results

The basic Results of the Economic Efficiency Calculation are shown here. Exactly which Results are shown depends on the amount of self-financing being made towards the total investment.

The Results shown here also appear in the Project Report.

The system's Net Present Value and the Electricity Production Costs are always calculated.

The Payback Period and the Net Yield are related to the amount of self-financing used. Therefore these Results can only be calculated when the amount of self-financing is greater than zero. If the investment is partly financed by borrowed capital, the programme calculates a Minimum System Operating Period, following which the amount of self-financing used and the loan payments have been recouped.

If the Minimum System Operating Period is greater than the Payback Period, the Minimum System Operating Period is given.

Exactly which graph is shown depends on whether the Payback Period or the Minimum System Operating Period is given.

If the Payback Period is given, the Cash Balance (Accrued Cash Flow) graph is shown.

If the Minimum System Operating Period is given, the Cash Balance less Outstanding Loans graph is shown.
You are able to select whether and how interest is calculated on the Payment Sequences:

1. **Discount Payments (Cash Value)**
   The reference point for this method of observation is the time before the start of the Assessment Period. The discounted interest on all payments is calculated at this point. The results of the Economic Efficiency Calculation form the basis of this type of assessment (Capital Value, Payback Period, Internal Rate of Return, Electricity Production Costs).

2. **Interest on Payments**
   The reference point for this method of observation is the end of the Assessment Period. It can be interpreted as the balance of account.
   For a payment, eg of €1000 in the first year, interest is calculated at n-times capital interest up to the end of the Assessment Period, for a payment in the second year, at n-1-times.

3. **No Interest on Payments**
   A payment of, for example, €1000 in the first year has the same value as a payment of €1000 after 20 years. This gives a clear view, but is not suitable for making economic decisions.

You can display 2 curves via the selection fields. If you only want to see one curve, you should select <no curves> in the 2nd Curve field.

**Print Graphic**
The graphic displayed can be viewed via the Print Preview before printing. The page is fixed to print in horizontal format.

**Copy Graphic**
The graphic displayed can also be copied to the clipboard, for example if you want to add it to your project report in Microsoft Word. You would have to export the project report into Microsoft Word first – this is done via the Print Preview.

For information on compiling the results, see also Results Overview
You are able to select whether and how interest is calculated on the Payment Sequences:

1. **Value of Payment Sequences (Cash Value)**
   
The reference point for this method of observation is the time before the start of the Assessment Period. The discounted interest on all payments is calculated at this point. The results of the Economic Efficiency Calculation form the basis of this type of assessment (Net Present Value, Payback Period, Net Yield, Electricity Production Costs).

2. **Pay Interest on Payment Sequences**
   
The reference point for this method of observation is the end of the Assessment Period. It can be interpreted as the balance of account. For a payment, eg of €1000 in the first year, interest is calculated at n-times capital interest up to the end of the Assessment Period, for a payment in the second year, at n-1-times.

3. **Do Not Pay Interest on Payment Sequences**
   
A payment of, for example, €1000 in the first year has the same value as a payment of €1000 after 20 years. This gives a clear view, but is not suitable for making economic decisions.

In the table's second column, the total payments over the Assessment Period are shown. No totals are shown for the Payment Sequences that have already been accrued. In respect of the Investment Costs, the Residual Value of the investment at the end of the Assessment Period is given in the final column.

Copy Table

The table displayed can also be copied to the clipboard, for example if you want to calculate your own results or to create your own graphics from within a spreadsheet programme.

For information on compiling the results, see also Results Overview.
11.3.1.6.3 Report

Here you are able to select the items that will appear in the Project Report.

The Results Overview gives details of the actual results, and this should always be printed out.

In addition, you can print a Detailed List of Income/Expenditure. This shows all the entries specified under the headings Balance of Costs and Loans.

You can also select which graphics you would like to appear in the report.

Click on Print Preview to take a look at the pages included in the report. From here you can print the report and create a PDF file. You can also export to Microsoft Word or other word processing programmes that accept documents in RTF format. You are then able to change the report layout, for example.
11.3.2 Economic Efficiency: Stand-Alone Systems

First of all you need to enter the parameters required for the Economic Efficiency Calculation. This is done on four different sheets:

- Parameters
- PV Costs, Breakdown of Costs
- Back-up Generator
- Financing

Once all the parameters have been entered you can view and print the results by clicking on the Economic Efficiency Calculation button.
11.3.2.1 Basic Parameters

The following parameters are entered on this page:

**Capital Interest Rate**
This is the interest on capital borrowed from the bank for the PV investment or the interest that could be charged on the capital used.

**Price Increase Rates**
Changes to running costs and fuel costs (if a back-up generator is to be used) are important for calculating the cash value of the system. Increase rates for electronics, batteries and the back-up generator can also be included.

**Lifespan**
The period given by the manufacturer as the expected lifespan of the system. For PV systems this is usually set between 10 and 25 years. The programme allows various lifespan periods to be entered for electronics, batteries and the back-up generator.

Economic Efficiency Calculation – Stand-Alone Systems
11.3.2.2 PV Costs, Breakdown of Costs

The following parameters for the PV system costs are entered on this page:

**Investment**
The investment can be given as an absolute amount or as a specific cost in €/kWp.

**Subsidy**
The subsidy can be given as an absolute sum, as a percentage of the investment or as a specific subsidy in €/kWp.

**Running costs**
The running costs can be given as an annual amount or as a percentage of the investment in percent per annum.

**Component Cost Allocation**
On this sheet the PV system costs can be split between its components: PV modules, electronics and batteries.

Economic Efficiency Calculation – Stand-Alone Systems
11.3.2.3 Back-up Generator

If a back-up generator is to be used, the costs are entered on a separate page.

Investment

The investment can be given as an absolute amount or as a specific cost in €/kW.

Running Costs

The running costs can be given as an annual amount or as a percentage of the investment in percent per annum.

Specific Fuel Costs

Fuel costs are entered as an amount per litre. The annual fuel requirement is shown after simulation.

Economic Efficiency Calculation – Stand-Alone Systems
11.3.2.4 Financing

Details on financing are entered on this page.

A loan can be loaded from the Database via the selection list or the folder button.

**Loan capital**
The amount of credit in € that is arranged.

**Term**
The time period that has been arranged for paying back the loan.

You also have to enter the Annual Instalment or the Loan Interest. In either case the other input field cannot be accessed and is calculated by the programme.

**Annual Instalment**
The set annual instalment which pays back the loan and interest within the credit term.

**Loan Interest**
The amount of interest that has to be paid on a loan.

If the loan interest rate is lower than the capital interest rate taking out a loan works like a subsidy, if the rate is higher the total costs increase. When interest rates are equal there is no difference.

Economic Efficiency Calculation – Stand-Alone Systems
11.3.3 Results Overview

The following payment sequences are available in the Results Overview:

- Total Investments
- Total Operating Costs
- Total Consumption Costs
- Total Other Costs
- Total One-off Payments
- Total Disbursements/Savings
- Total Subsidies
- Total Loan Payments
  Interest plus Repayments
- Total Loan Interest
- Payment Received for Grid Supply
- Electricity Savings
- Self-Financing
  Total of Investments, One-off Payments less Subsidies
- Depreciation
- Result before Tax
  Total of:
  - Operating Costs,
  - Consumption Costs,
  - Other Costs,
  - Subsidies,
  - One-off Payments
  - Disbursements/Savings
  - Payment Received for Grid Supply
  - Electricity Savings
  - Depreciation
  - Loan Interest
- Tax Rebate
  Is calculated using the Marginal Tax Rate from the Result before Tax.
- Result after Tax
  Result before Tax plus Tax Rebate
• Cash Flow after Tax
  Total of:
  - Operating Costs,
  - Consumption Costs,
  - Other Costs,
  - Disbursements/Savings
  - Payment Received for Grid Supply
  - Electricity Savings
  - Loan Payments
  - Self-Financing
  - Tax Rebate

• Outstanding Loan Payments
  Payments are listed here which at the time require interest and repayments to be paid.

• Cash Balance (Accrued Cash Flow)
  Total Cash Flow after Tax

• Cash Balance less Outstanding Loans
12 Results Menu

With PV*SOL® you have a number of alternatives for evaluating the simulation results. The results are not saved, as the results files would be too large and you can simply and quickly re-run a simulation whenever you wish.

There is, however, a roundabout way of saving the results if required. This is done from within the Graphics facility in the Table menu command.

Most menu commands are only activated (ie the lettering is black not grey) after simulation. However, you are able to view the data loaded from the Climate data files, the parameters entered under Technical Data in the Detailed Project Report and the Variant Comparison at any time.

Annual Energy Balance
Energy and Climate Data...
To Grid Credit
From Grid Costs
Pollutant Emissions
Project Report
Variant Comparison
12.1 Annual Energy Balance

The quickest way to view the most important results after simulation is to go to the Annual Energy Balance.

The annual results for energies and various evaluation dimensions are given in table format.

The output values vary according to the type of system.

If you have defined a PV system with a number of arrays the values for each array are each given on a separate sheet.

You will find more details on output values under the heading Definitions.

If you want to print the results go to Project Report/Summary.

If you want to view the values over a period of time go to Energy and Climate Data.
12.2 Energy and Climate Data Presentation Graphics ...

With the assistance of the Graphics function you are able to print out or display on screen all of the results like annual variations in climate data (radiation, temperature, wind), PV array power output, energy supply to and from the grid, energy requirement for electrical appliances, and evaluation values such as energy supply and performance ratios can be displayed, for any period in the year and simulated, in hourly, daily or monthly format.

A window for Graphics selection appears.

The majority of values and simulation results can first be seen after Simulation, only the climate data horizontal radiation, wind speed (scalar) and external temperature can be viewed before simulation.

If you have defined a PV system with a number of arrays, a curve for each array is displayed on a separate sheet.

1. Select up to 8 result data records from the various pages and have them displayed as graph. You can also open a number of graphics windows and sort them on the screen as you wish.
   - A further selection depends on the type of system selected.
   - Details on the result values can be found under Definitions
   - The curves on the sheet labelled "Climate Data" are available for selection with all systems.

2. Click on OK to exit the selection dialog and the graph appears.

3. The results can be viewed and printed as curves. The presentation format can also be changed as required:
   - All axes and axes' labels can be formatted and repositioned.
   - The output values can be presented as a line graph or a bar chart.
   - The selection of colors used can be changed.
   - The scale of the axes and the position of the axes’ coordinates can be adjusted.
   - The legend text can be dragged and dropped over the whole document area and the title can be edited with a double click.

4. The results can also be displayed in table format and saved as an ASCII file if you want to use an external programme to evaluate the data.
12.2.1 Graphics Screen

Legend
This field contains a description for each data record being displayed.

If energies are illustrated, the sum of the energy in the selected period is shown next to
the name of the data record.

Power output, temperatures, wind speed and evaluation quantities (energy coverage,
performance ratios and efficiencies) are displayed as mean values for the period.

Title
Give the graph or chart a new title by double clicking on the title frame. A dialog window
opens. When you close this window the new title appears in the title frame. Drag and drop
the title to any position within the graphics window.

Co-ordinates Field
At the base of the graphics window a field displays the actual co-ordinates indicated by
the mouse pointer when it is located within the diagram. The date and time, as well as the
x-value for the position of the mouse pointer are shown.

Selecting and Amending the Data and Axes
Select the individual data records or the x and y-axes by a single click of the left mouse
button. The selection is shown by points along the lines in a line graph and on the bars in a
bar chart. Click just below the lines for a line graph and the x axis, just under the top of
one of the bars for a bar chart and to the left of the line for the y-axis.

By double clicking on the x or y-axes the dialog window Formatting the X-Axis or
Formatting the Y-Axis appears.

12.2.1.1 Graphics Screen Speed Buttons
By using the speed buttons you can perform a variety of functions and quickly change the
format of the selected parts of the graph or chart or axis.

   - Print Graphic
   - Copy Graphic (e.g. to paste into EXCEL for further processing)
   - Go to next or previous time period
   - Go to first or last time period
   - Enlarge or reduce font size of selected area of graphic
   - Change between normal and bold font in selected area of graphic
   - Change font
Change selected data record to line graph or bar chart

Add grid lines
12.2.2 Formatting of Graphs

The menu labelled Graphs lists the (selected) data records that can be displayed in graph, chart or table form.

For each data record the menu command Own Y-Axis enters an additional y-axis into the diagram assigned to the data record selected.

Under Graphs you can select a data record and at the next menu level select a variety of formatting options. Here you can select line graph or bar chart format and bold or normal line display.

With change color you can select from a wide range of colors for the lines or bars in your graph or chart.

By choosing the command invisible the selection is suppressed but not deleted.
12.2.3 Formatting the X-Axis

In this dialog window you can define the time period to be displayed in a graph or chart as well the time period over which the data record values are to be summarised or averaged out.

Column Width
The column width represents the time period within which the data is presented. Depending on which unit you have selected, the data record values are either summarised (energy) or averaged out (power output, temperatures) for the interval selected.

Display From
The date from which the data displayed in the graph should begin is entered here (in date format).

Display Interval
Here you should enter the period over which the data should be displayed in the graphic.

Units
The choice of units for the bar width and display interval (hours, days, weeks, years) is made from the pull down menus. You will need to enter the multiples of these units in the fields provided.
12.2.4 Formatting the Y-Axis

The y-axis is formatted in this dialog window.

**Unit**
Select the unit to be displayed from the field labelled Unit. If you select Position on Right the y axis will be placed on the right-hand side of the diagram.

**Position of the Y-Axis**
In this field you can select the cross-over point of the axes. You can select either minimum (zero) or maximum, or you can enter a value yourself.

By selecting the field Own Scale you can format another y-axis for the selected data record.

**Minimum Value**
Enter the smallest value to be illustrated for the data record.

**Maximum Value**
Enter the largest value to be illustrated for the data record.

**Main Intervals**
The labelled intervals along the y-axis.

**Sub-Intervals**
The division of the main intervals along the y axis.
12.2.5 Printing Graphics

The usual WINDOWS print dialog appears in which you can select the settings and printer desired.
12.2.6 Graphics in Table Format

The graphs selected in the Energy and Climate Data... dialog window can be displayed in table format. Just click on the Table menu to switch to table format.

The various recording stages and intervals are incorporated from the graph into the table. If you want to change these go to the menu Axes › X-Axis, and make the changes in the dialog window. You can also quickly change the display interval units from the Display menu.

Clicking on the menu Line › Bar switches back to line graph › bar chart format.

The position of the decimal point depends on the y-axis’ main interval setting. To Edit the main interval setting you have to first go back via the Line › Bar menu and then to Axes › Y-Axis. You can then make amendments to the main interval or the units and then go back to Table.

From the File › Save As menu you can save the results as an ASCII file and from File › Copy you can copy the values for pasting into other spreadsheet programmes such as EXCEL (or use the speed button).
12.3 Income from Export to Utility Grid - Feed-in Payment

This menu point is first activated after a simulation has been carried out.
The tariff forming the basis of the calculation is shown in the Tariff Name field.

Energy fed into the grid is shown separately for high and low tariff rates and for summer and winter.
The remuneration received for the electrical energy is provided on the basis of the tariff selected and the amount of energy exported to the grid.
The calculation results for the Payment Received for Grid Supply are printed in the Economic Efficiency Calculation.
12.4 Outgoing Cost of Energy from Utility Grid

Here you are given a detailed list of variables for energy use under the headings: Kilowatt-Hours, Load and Discounts/Supplements, and the resulting costs (payments to the electricity utility). The values are given for two scenarios: With PV System and Without PV System.

Without PV System - the cost of electricity used is determined by the energy consumption of the electrical appliances.

With PV System – the cost of electricity used is determined by the amount of energy drawn from the grid.

Depending on the supply concept (see Tariffs), the energy used by the electrical appliances plus the energy used by the PV system itself is provided exclusively by the grid (Full Supply), or, with Net metering, the amount of energy generated by the PV system must be deducted from this amount.

The name of the tariff on which the calculation is based is shown in the field at the top of the window. The tariff is defined under the menu Conditions › Tariffs.

The results of the tariff calculation are given in a detailed table, divided into three areas: Work, Power and Discounts/Supplements. A summary with the final result Total Payment is given in a field at the bottom of the window.

**Work:**
Specific Costs: Average specific costs in the given period.

Energy from Grid: The number of kilowatt-hours of energy drawn from the grid in the given period.

Costs: costs before the deduction of discounts and the addition of supplements.

Payments: costs after the deduction of discounts and addition of supplements.

**Power:**
Set Load Price: the set demand price as entered or the estimated price for wholesale provision of power to the utility.

Heavy Load Peak: for heavy/light load capacity measurement, the heavy load peak is given here.

Billing Load (Output Value): The output that is included in the billing calculation is given here, or, if a 96 hour tariff is in use, the output value is given.

Specific Load Price: Average specific load price in the given time period.

Consumption Dependent Load Price: billing load * specific load price.

Total Power Payment: represents the sum of the set and consumption dependent power prices after deduction of discounts and addition of supplements.
See also: Databases > From Grid Tariff > Power Measurement

Discounts/Supplements:
You are not able to enter values in this window.

Set Costs: The set costs defined in the Discounts and Supplements dialog.

Hours of Full Utilisation: from quarter hour power measurement, the total hours of full utilisation and the resulting load utilisation period discount are provided.

Other Discounts, Supplements: the rebates and supplements entered in the "Discounts and Supplements" dialog are also shown here.
12.5 Pollutant Emissions

This menu point is activated after simulation has been completed.

Here you can view the values for the pollutant emissions that have been avoided by use of the PV system.

The evaluation of pollutants varies for energy consumption and for energy provision to the grid.

With the "Own Use" supply concept (see Tariffs) the energy supplied by the PV system replaces the energy from the grid. This is evaluated in the Pollutants dialog in the column labelled "Specific Pollutant Emissions per kWh of Electricity" for the electricity consumed by the appliances.

The electricity supplied to the grid by the PV system is also evaluated in the Pollutants dialog, as a value of "Specific Pollutant Emissions per kWh of Electricity" avoided by feeding the energy into the grid.

Emission values required for the calculations are entered under the menu heading Conditions/Pollutant Mix.
12.6 Project Report

The results of the simulation are presented and can be printed out in the Project Report. There is a one page Summary containing the most important simulation results and a multi-paged Detailed Project Report, that also contains the results of the Economic Efficiency Calculation.
12.6.1 Summary Project Report

This dialog is a page preview (see Page Layout) of the one-paged project summary. This can also be printed out.

The System Diagram is shown. Each array is allocated a PV symbol with details on the number, manufacturer and type of modules, the power output, tilt, orientation and type of mount. If the design includes multiple inverters the sketch will also include an inverter symbol for each array, indicating the number, manufacturer, type and output. Depending on the supply concept selected (Own Use or Full Supply), the meter symbols are arranged differently. Values for the supply to grid tariff and the appliances’ annual consumption are given as text with the appropriate symbol.

The annual results are basically the results of the Annual Energy Balance for the entire system. In addition, the level of CO\textsuperscript{2} emissions avoided is given in the pollutant balance results.
12.6.2 Detailed Project Report

The Detailed Project Report is made up of three sections and can be viewed in preview (see Page Layout).

The first section gives the System Data for the PV system (System menu) and the appliances (Appliances menu). The types of modules and inverters used are given in the details for manufacturer, type, output and efficiency.

The system data can also be produced before simulation.

In the second section, the Detailed Results are presented. These basically consist of the Annual Energy Balance results plus a number of other results.

In addition, a graph illustrating the solar energy produced, the energy requirement and the supply of energy to the grid is provided. With the supply concept “Full Supply” the solar energy produced equals the amount of energy supplied to the grid.

In the third section the Economic Efficiency for stand-alone systems can be printed. If you want to change the parameters (investment, subsidy, interest etc) go to the Calculations/Economic Efficiency Calculation... dialog. For grid connected systems, the Economic Efficiency Calculation can be printed from the Economic Efficiency Calculation – Grid Connected systems dialog.

You can print the roof layout as a separate document via the menu: Results > Project Report > Roof Layout. This function is only active if the roof layout has been used in the project. Alternatively, you can select the detailed project report via the menu: Results > Project Report > Detailed Project Report, and then decide whether you want to include the roof layout in the detailed project report. If so, select the Roof Layout option.

All three sections can be printed separately. Click on the button and a Print dialog appears showing the sections that can be printed and the number of copies.
12.6.3 View Page Layout

This dialog allows the page layout of documents that can be printed to be viewed before printing.

Where there are number of pages, you can move easily between pages:

- either click on the arrow buttons ▶️ ▶️ in the menu bar, or
- or use the scroll bar on the right of the screen.

If there is only one page, no arrows are displayed.

When scrolling down a page (click on the black arrows in the scroll bar) the page will move to reveal any part of that page that is out of view, or the screen will move straight to the next page.

If the cursor is positioned within the area where it appears as a magnifying glass 👀🔍, the page being viewed can be enlarged or reduced. A "+" in the magnifying glass means that the view area can be enlarged, and a "-" means that the view area can be reduced. The area directly around the magnifying glass is enlarged.

Click on the printer symbol button 🗿 to open the Print dialog.

› See also:
  
  Detailed Project Report
  
  Project Summary
12.6.4 Print dialog

The standard printer is the printer selected in WINDOWS’ system settings. If you want to print to another printer, go to the Select Printer dialog by clicking on the Settings button.

In addition, towards the bottom of the dialog, you can see the Subjects that can be printed out. (Normally only one title is included.) At least one subject must be selected.

The number of copies that you want to print should also be entered in this window.
12.7 Variant Comparison Selection

In this window you can select the projects you want to compare in table format from the list of existing projects.

After the selection of systems has been made (not available with PV*SOL®-N for grid connected systems only), the projects will be shown together in a table – grid connected or stand-alone systems are grouped and listed separately.

A selection is made by marking the project required and moving it into the selection list.

- Click on this button to select the projects. You can also drag and drop highlighted projects into the list.
- With this button you can deselect projects from the list. Click on the field labelled Current Project to load the current project into the comparison table, provided it belongs to the selected system type.

Comparison Table

Click on OK to exit the dialog and another dialog opens in which the most important parameters and a summary of the simulation results are displayed.

The window has its own menu with the Close and Copy commands. The Copy command copies the table, so that the variant comparison can be pasted into external spreadsheet or word processing programmes for evaluation and printing out.

The dimensions produced are different for grid connected and stand-alone systems. The table headings, however, remain the same for both systems.

Table Headings

- File Name: the file name is set when the project is saved. If the current project has been selected but not yet saved, the file name Current Project is allocated. Otherwise the file name is given without the directory path – eg Solar1.prj. The current project's file name is displayed at the top of the main screen.

- Variant Reference: the project variant reference can be entered at the top of the main screen or is given as the file reference when saving the project.

- Project Name: the name of the current project is entered in the first line of the "Project Administration" dialog and shown at the top of the main screen.

- Climate data file: the climate data for the current project is also displayed at the top of the main screen. The climate data file that was last loaded is used for all new system designs. The climate data can be changed via the Conditions/Load Climate Data File menu. Climate data files have the file extension * .wbv.
12.7.1 Variant Comparison

The projects selected in the Variant Comparison... are set out in a table in this dialog. The most important parameters are shown, as is a summary of the simulation results. The window has its own mini-menu with the Close and Copy commands. The Copy command copies the table so that you can paste the variant comparison table into spreadsheet programmes such as EXCEL or into word processing programmes.
13 Database Menu

Projects designed with PV*SOL are made up of individual components.

These components are loaded as files from the comprehensive database that comes with the full programme. This means that you simply have to load the individual Components from the files provided.

These databases are maintained by the manufacturers of the components, in particular the PV modules, we make them available to you as biweekly database update.

From the Database menu you can view the various database sections, make changes and add new data sets.

When creating and configuring a system, you must load components from these databases. It is not possible to modify the component values. The feed-in tariff and the individual appliances are exempt from this rule. The To Grid Tariff can be entered from a number of positions within the programme. At the menu command Conditions > Tariffs you are able to load and define a tariff. And under Calculations > Economic Efficiency Calculation... you are also able to set a tariff for exporting energy to the grid. It therefore isn't absolutely necessary to enter this tariff via the database.

For all databases PV*SOL monitors whether:

1. changes have been made to the data contained in the files loaded into the project you are currently working on,
2. the files loaded into the project you are currently working on still exist,
3. a dialog used for loading files from the database has been closed without first loading a file.

If so, a corresponding Message will appear.

13.1 Create your own component data sets

You can create your own data sets in the menu Databases. While creating and editing a project, you cannot edit components.

Proceed as follows:

1. Go to the menu Databases and select the desired component database. A data sheet is displayed.
2. Click the button Load to select a well suited component.
3. Overwrite the data, in particular the name (e.g. for PV modules this is the edit field "Type")
   and

4. save your entries by clicking "Save as ..."

→ see also:

Editing Projects

**13.2 Component Data**
13.2.1 PV Module

Here, on a number of worksheets, you can set the characteristics for the PV modules. Details on using the database are given under Project Design.

As in all database dialogs, there are the Load, Save and Close buttons and there is also a Print button.

13.2.1.1 Basic Data:

Manufacturer and Type are allowed a maximum text length of 50 characters.

Output Tolerance [%]
The given module values are subject to fluctuations during manufacture. This is relevant mainly for the specification of current, voltage and power output.

Cell Type
The majority of cells consist of mono-crystalline or poly-crystalline silicon, with a few made of amorphous silicon.

New cell types will, however, soon be available.

Dimensions: Height [m], Width [m]
The height and width determine the module surface and therefore the PV array surface area. This surface area, based on the measurement of the modules, is referred to in the programme as the Gross Module Surface Area.

13.2.1.2 U/I Characteristics under STC:

The specifications on this page are only valid for standard test conditions (STC). This means a module temperature of 25°C, a sunlight spectrum of AM 1.5 and 1000 W/m² irradiation.

MPP Voltage [V], MPP Current [A]
The power output of the modules is dependent on the module temperature and irradiation, and the module voltage. For each module temperature and irradiation value there is a current/voltage characteristic curve, and the working point on this curve determines the modules’ power output.

The MPP is the working point on this curve (see also the U/I characteristic curve button on the sheet: U/I characteristics - part load) where the power output of the modules is the greatest (Maximum Power Point).

The MPP voltage and the MPP current are dependent on temperature and irradiation. This means that the voltage and current given here are only valid for standard test conditions. For all other irradiation and temperature values there is another MPP. This must be defined by the programme (see: U/I characteristics - part load).

Within the PV system this task is carried out by the inverter, which regulates the voltage of the PV generator to maximise current and voltage production (MPP tracking).
No-Load Voltage [V]
The voltage that arises when the module is load free. This value is also dependent on temperature and irradiation.

Short Circuit Current [A]
The electricity that flows through a short circuited module. This is also temperature and irradiation dependent.

Specified Power Output [W]
The power output that the module produces under standard test conditions according to the manufacturer’s data sheets. The actual power output is defined from the module voltage and the module current, and is given in the Calculated Power Output field. In defining the installed PV power output, PV*SOL® always refers to the calculated power output.

Efficiency [%]
The module efficiency rate under standard test conditions. For the simulation, the programme determines the Solar Module Surface Area from the calculated power output and efficiency with the following formula:

\[
\text{Nominal output(STC)} = 1000 \text{ W/m}^2 \times \text{ETA(STC)} \times \text{Solar module surface area}
\]

13.2.1.3 U/I Characteristics under Part Load Conditions:
Current and Voltage for a second working level are entered on this page. The values for a lower level of irradiation are important in order to be able to calculate the module efficiency curve. The efficiency specifications in data sheets are based on a module temperature of 25°C and irradiation of 1000 W/m², although for most of the year these levels are seldom reached. The efficiency rate at a lower level of irradiation is therefore very important for the simulation results. There are a number of important points to consider when determining the second working point (Module Efficiency - Part Load). Click on the Help button to view these. The programme will calculate the second working point for you if you click on the Typical Part Load Efficiency button.

You can view a graph of the characteristic curve calculated by the programme by clicking on the Efficiency Curve, U-I Curve or U-P Curve buttons.

13.2.1.4 Other Characteristics:

Temperature Coefficients:

Voltage Coefficient [mV/K]
This value expresses how many degrees the voltage decreases when there is a rise in module temperature. The hotter the module, the lower the voltage, i.e. this coefficient is negative.
Current Coefficient [mA/k]
This value shows by how many amps the current increases when the module temperature rises. The higher the module temperature, the higher the current, ie this coefficient is positive.

Power Output Coefficient [%]
The hotter the module, the lower the power output. This coefficient is negative and is proportional to the nominal output.

Incident Angle Modifier [%]
The incident angle modifier is a characteristic of the material covering the module (glass). The glass reflects part of the radiation away from the module resulting in a loss of current. The incident angle modifier reduces the amount of direct radiation falling onto the module. The correction factor for diffuse radiation lost through reflection is assumed at 95%.

Maximum Module System Voltage[V]
Each electrical appliance has a maximum voltage limit. This value refers to the maximum voltage that a array can support in order to ensure that no damage is caused to the modules. If the maximum voltage is too high, you should reduce the number of modules in series.

Specifications for the Dynamic Temperature Model:

Heat Capacity [J/(kg*K)], Absorption Coefficient [%], Emissions Coefficient [%], Weight [kg]
These are the parameters for the dynamic temperature model required for working out the thermal balance equation.

Click on Load to load one of the module files provided, to check on the values and correct if required.

Click on Save to save the values you have entered, either in the current file or as a new file. A message appears before a file is overwritten.

Close exits the dialog without a message appearing.
If you want to print out the file that has been loaded last click on Print. This will be printed on the standard printer as specified in printer set-up.
13.2.2 Module Part Load Operation

The module’s operation under part load conditions is calculated from the specifications for no-load voltage, short circuit current, MPP voltage and MPP current with low irradiation and a module temperature of 25°C.

The second working point, ie the choice of irradiation level, has to be set under certain restrictions. It must be selected so that, at the irradiation point set, the fill factor is at maximum, or so that, with lower irradiation, the fill factor becomes considerably smaller and with higher irradiation the fill factor is around the maximum value.

The definition of the fill factor is:

\[ FF = \frac{(MPP \text{ current} \times MPP \text{ voltage})}{(\text{short circuit current} \times \text{no-load voltage})} \]

The fill factor (FF) is dependent on the irradiation. If a FF above the irradiation is applied, this results in the fill factor function. Depending on the module and the irradiation, the FF is usually set at around 55% and 85%.

If you don’t have any suitable specifications for part load operation, you can run the calculation with standard values by clicking on the Typical Part Load Operation button.

For most modules, the irradiation at the fill factor maximum is 300 W/m². The fill factor is set at 5% above the FF under standard test conditions. Linear part load operation is given for the current.

After you have entered the values for module part load operation, it is essential to take a look at the efficiency characteristic curve and to test that there are no discrepancies.
13.2.3 Inverter – Grid Connected Systems

The characteristics for the inverter are entered in this window. Details on using the database are given under Project Design.

If you want to enter an inverter that can be switched to different voltage levels, you will have to enter the individual voltage fields as separate inverters with the characteristic data for each of these.

As in all database dialogs there are the Load, Save and Close buttons and there is also a Print button.

Manufacturer and Type are allowed a maximum text length of 50 characters.

DC Power Rating [kW]
DC stands for direct current and refers to the input side of the inverter. As this value is not clearly defined by inverter manufacturers, it is no longer used in PV*SOL and is shown for information only.

Max. DC Power [kW]
This value is also not clearly defined by inverter manufacturers. It is no longer used in PV*SOL and is shown for information only.

AC Power Rating [kW]
AC stands for alternating current and refers to the output side of the inverter. The AC power rating is the output that the inverter is designed for when in continuous operation. When the inverter is in continuous operation the power output is limited, with the AC power rating being the upper limit.

Max. AC Power [kW]
The output that the inverter can produce in 10 minutes. This value is not currently used in PV*SOL.

Stand-by Consumption [W]
If no energy is being delivered into the grid or to the electrical appliances, the energy required by the inverter itself still has to be accounted for. In addition to the stand-by consumption there is also night consumption.

Night Consumption [W]
The inverter switches itself off during the night, but still uses a small amount of energy.

Input Level [W]
The minimum amount of energy to be produced by the PV generator before the inverter can function.

Nominal DC Voltage[V] / Nominal DC Current [A]
The input voltage or the input current of the inverter, when delivering nominal power output.

Number of MPP Trackers
The number of independently operating MPP regulators.
For multi-string appliances, this value is greater than 1.

Max. Input Current per MPP Tracker [A]
This current limit per MPP tracker should not be exceeded. (Only active if the number of MPP trackers is greater than 1.)

Max. Recommended PV Output per MPP Tracker [kW]
See Max. Recommended PV Output [kW]

Maximum Input Voltage [V] / Maximum Input Current [A]
This level of voltage or current should not be exceeded, otherwise the inverter will be damaged.

Upper and Lower Voltage Levels for the MPP Range [V]
Within this voltage range, the inverter is able to control the MPP tracking. The inverter finds the optimal voltage for the PV generator within this range, so that the generator’s power output is maximized.

MPP Adjustment Efficiency [%]
The adjustment efficiency provides a measurement of how close the inverter’s working point is to the PV generator’s maximum power point (MPP). The programme differentiates between the power ranges <20% and >20% of the nominal output. The adjustment efficiencies are taken into account during simulation in defining the inverter’s performance ratio.

Characteristic Curve - Inverter
This button opens the Characteristic Curve – Inverter dialog, so that you can enter the conversion efficiency depending on the input power. These values should be obtained from the inverter manufacturer.

The European efficiency is calculated with the following formula:

$$W_{g(EU)} = 0.03 \times W_{g(5\%)} + 0.06 \times W_{g(10\%)} + 0.13 \times W_{g(20\%)} + 0.1 \times W_{g(30\%)} + 0.48 \times W_{g(50\%)} + 0.2 \times W_{g(100\%)}$$

Deviation of the Input Voltage from the Nominal Voltage
The inverter’s efficiency characteristic curve is entered for the nominal voltage. If the inverter is not operated at its nominal voltage, there is a change in the efficiency of the inverter. Whether the efficiency increases or decreases is dependent on whether the inverter has a transformer, or not. The following can be used as a rule of thumb:
• The efficiency of an inverter with a transformer reduces with rising input voltage by about 1% per 100 V.
• The efficiency of an inverter without a transformer increases with rising input voltage by about 1% per 100 V.

Click on Load to load one of the inverter files provided, to check on the values and correct if required.

Click on Save to save the values you have entered, either in the current file or as a new file. A message appears before a file is overwritten.

Close exits the dialog without a message appearing.

If you want to print out the file that has been loaded last click on Print. This will be printed on the standard printer as specified in printer set-up.

See also:
Inverter
Inverter – Stand-Alone Systems
13.2.4 Inverter – Stand-Alone Systems

The characteristics for a stand-alone system inverter are entered in this window. Details on using the database are given under Project Design.

Manufacturer and Type are allowed a maximum text length of 50 characters.

Nominal DC Output:
The direct current flows into the inverter. The nominal output is the power rating at which the inverter, under continuous operation, is designed to run.

Nominal AC Output:
This refers to the current that flows out of the inverter. The nominal AC output is the power rating that is available for the electrical appliances connected to the system.

Stand-by Consumption [W]:
If no energy is being delivered into the grid or to the electrical appliances, the energy required by the inverter itself still has to be accounted for.

Nominal DC Voltage:
The nominal DC voltage must match the battery's nominal voltage.

Nominal AC voltage:
The voltage corresponds to the nominal voltage of the appliances.

Characteristic Curve – Inverter:
This button opens the Characteristic Curve – Inverter dialog, so that the you can enter the conversion efficiency depending on the input power. These values should be obtained from the inverter manufacturer.

See also:
Inverter
Inverter – Grid Connected Systems
13.2.5 Inverter Characteristic Curve dialog

The conversion efficiency is the relationship of the power output to the power input, dependent on the inverter power at that time.

The specification of the efficiency given in manufacturers’ data sheets relates to the nominal output (power rating), which PV systems, however, are not able to deliver at most times of the year. Therefore the part load operation is much more important for the simulation results.

The programme requires 7 support points to define the characteristic curve, ie the efficiency at 0, 5, 10, 20, 30, 50 and 100% of the nominal output.

To view the characteristic curve in graphic form, click on the Graph button.

For grid connected systems, the European efficiency support points are fixed and displayed. If changes are made, these are first calculated on exiting the entry field.

See also:

Database: Inverter
13.2.6 Battery (not available with PV*SOL®-N for grid connected systems only)

The following battery characteristics are entered in this dialog:

Manufacturer and Type:
You are allowed to enter a maximum of 50 characters.

Voltage:
The battery’s nominal voltage.

C20 Capacity: Battery capacity with a discharge time of 20 hours.

Capacity:
The product of voltage and C20 capacity. This is calculated within the programme by clicking on Calculator.

Self-Discharge:
The details from the battery’s product data sheet should be recalculated to % per day.

Average Charge and Discharge Efficiency:
If you do not have these specifications to hand, please use the programme's default values.

Click on Load to load one of the battery files provided, to check on the values and correct if required.

Click on Save or Save as... to save the values you have entered, either in the current file or as a new file. A message appears before a file is overwritten.

Close exits the dialog without any message appearing.

If you want to print out the values from the file that has been loaded last click on Print. The information will be printed on the standard printer as specified in printer set-up.
13.2.7 From Grid Tariff

The tariff for electricity from the utility grid used by the electrical appliances is defined here. For more information on how to use the database see: Project Design.

From the Load and Save File dialog and you are able to load a tariff file from the database or save a tariff file to the database [*tar].

The tariff reference is given in the field labelled Name.

High Tariff and Special Tariff Periods are defined in the Tariff Time Periods dialog. These times are valid for electricity drawn from the grid as well as for energy exported to the grid.

The kilowatt-hour prices for each tariff time period (ie HT – high tariff, LT – low tariff and ST – special tariff) are entered in the Kilowatt-Hour Price dialog.

Click on the Power Measurement button to define the type of power measurement (¼ hour power measurement, 96 hour measurement) In addition, the prices for the energy provided by the grid utility is defined here and the light or heavy load periods are entered.

The grid utility discounts and supplements can be entered separately in the Discounts and Supplements dialog.
13.2.7.1 Tariff Time Periods

The high tariff periods (HT) and any special tariff periods (ST) are defined here. These tariff periods are valid for the supply of energy both to and from the grid utility.

Winter Time: From... To:
Entry of the tariff period for winter is made in dd.mm format.

Different Tariff Periods – Summer/Winter:
Select to enter separate tariff periods for summer and winter.

- Define Special Tariff Periods:
  Select to create a new worksheet for the entry of a special tariff period in addition to high and low tariff periods. Separate kilowatt-hour rates can be entered for these times in the Kilowatt-Hour Price dialog. When a high tariff period is also defined as a special tariff period, this period is valid as a special tariff period.

- New HT Periods Valid From:
  With the assistance of these selection fields you can define which days in the week different tariff periods are valid on. The first column shows on which days of the week the times entered are valid.

High Tariff Periods:
You can enter up to 5 time periods (from ... to ... hours) per day. Enter these values in time format.

→ See also:
From Grid Tariff
13.2.7.2 Kilowatt-Hour Price

The price per kilowatt-hour for each tariff period - high tariff (HT), low tariff (LT) and any special tariff (ST) - is defined in this dialog. In order to be able to define the tariffs for special periods, these have to be entered under Tariff Time Periods.

Inflation:

The rates that need to be entered into the table are basic prices that produce the kilowatt-hour rate when multiplied by the Inflation. With the Inflation the grid utility company takes the current energy price and eg. wage increases into account. Normally, only the basic price level is used in the low voltage range, so that the Inflation is 1 in this case.

Summer/Winter Different:

Different kilowatt-hour rates can be entered for summer and winter times. In this case the prices are not valid for the whole year’s energy consumption, but for summer and winter periods. If at the same time Different Pricing Bands for Each Tariff Period is selected you can separate out the kilowatt-hour rates for summer and winter periods into high and low tariffs.

Staggered Consumption Regulation:

If this selection is made the valid kilowatt-hour price is given as follows:

- With a total annual consumption during HT periods of 600,000 kWh, for example, the price band starting from a consumption level larger than 500,000 kWh is valid, for the total energy produced during the HT period HT energy the basic price of 0.35 €/kWh is valid.

Consumption Zone Regulation:

On making this selection the text of the first column changes in order to make the prices given clearer. "Consumption larger than" becomes "Each further kWh from". The valid kilowatt-hour rate is given as follows:

- With a total annual consumption during HT periods of 600,000 kWh, for example, a basic price of 0.36 €/kWh for the first 250,000 kWh is valid, for the second 250,000 kWh the basic price of 0.35 €/kWh is valid and for the final 100,000 kWh a basic price of 0.33 €/kWh is valid.

The total HT kilowatt-hour rate is therefore calculated as follows:

Total HT kilowatt-hour rate : (250.000 kWh * 0.36 €/kWh + 250.000 kWh * 0.35 €/kWh + 100.000 kWh * 0.33 €/kWh) * Inflation

Different Pricing Bands for Each Tariff Time Period:
On making this selection the kilowatt-hour rate for each tariff period is given its own worksheet. In this case the valid pricing band is no longer given as the total annual consumption, but as the total consumption in the time period that is valid for each worksheet. If, for example, Summer/Winter Different is not selected, then the valid kilowatt-hour rate for the winter HT is only given in the total consumption for summer and winter HT.

→ See also: From Grid Tariff
13.2.7.3 Power Measurement

The basic specifications for power measurement are entered in this dialog. Further specifications can be made depending on the type of power measurement selected. The following power measurement categories are available:

**Type of Power Measurement**
- No Power Measurement
- 96 Hour Measurement
- Standard Calculation (¼ hour power measurement)
- Light/Heavy Load Maximums

**No Power Measurement**
If the tariff for energy supply from the grid suffices without power measurement, then you should select "No Power Measurement”.

**96 Hour Measurement**
With the 96 hour tariff the electricity consumption in kWh within 96 consecutive hours is added together in a consecutive time window. These hourly values are called power values (Pow. Val.). The highest power value within the time period measured is used for the calculation of power payment. The power payment is the sum of the highest power value multiplied by the valid load price for annual electricity consumption according to the given pricing band.

During 96 hour measurement with time zone regulation, the recording of the power values during low tariff is suspended without changing the consecutive timing for the 96 hour measurement periods. In this case Measurement Only During HT Periods must be selected in the Load Price dialog.

**Standard Calculation (¼ hour power measurement)**
This calculates the power from the average value of the highest monthly power output figures. The number of months that are used to calculate the maximum annual power output is entered in the Load Price dialog.

**Light/Heavy Load Maximums**
¼ hour power measurement, with the time period used for providing the billing load being limited to the so called heavy load periods. These heavy load periods are entered in the Heavy Load Periods dialog. Further definition of the heavy load peak is described under Standard Calculation.

The lowest monthly light load is entered separately.
Output peaks during low output periods are only considered if the monthly low output peak reaches a level above the given annual peak power output at peak load times. The monthly differences of these values are sorted according to size and an average value is calculated. The resulting difference is only partly used in the calculation, the factor is entered in the Load Price dialog. The number of months used for producing a figure for the light load peak is also entered in the Load Price dialog. The sum of the heavy load maximum and the allowed for light load share gives a figure for the calculated power.

**Set Load Price:**
The electricity payment is made up of two parts: a set price and a price dependent on consumption. The set load price must always be paid separately from the price for grid power actually used.

**Hourly Peaks in the Defined Load Plus:**
(only for Standard Calculation and Heavy/Light Load Maximums)

Depending on the grid utility company, monthly power outputs are measured in ¼ or ½ hour averages. The highest output during the year is multiplied with the given specific load price, in order to give a figure for the annual load price that will have to be paid. In the programme the highest monthly output figure is the highest occurring average hourly output in each month (to account for the time stages). This leads to lower output peaks because the ¼ hour variations are levelled out. In order to correct this the highest monthly outputs for calculating the highest annual output are multiplied by the ¼ hour peaks in the defined loads plus. Depending on the type of appliance, the size of the area supplied, and any measured loads to hand, a percentage figure between 0% and 50% must be entered here. For typical housing estates with an annual consumption of more than 100,000 kWh, an annual consumption of 5-10% can be used for the calculation.

**Minimum Power Output:**
(only for Standard Calculation and Heavy/Light Load Maximums)

This measure is only used in the calculation if the maximum output is less than this value.

**Wholesale Provision:**
(only for Standard Calculation and Heavy/Light Load Maximums)

Instead of a set load price, a price for wholesale provision can be requested. This is paid if the hours of full use (HFU) do not reach the set threshold value. The wholesale provision price (WPP) is calculated as follows:

\[ WPP = \text{price \([\text{\€/kW}]\)} \times \text{max. power output} \]

\[ \times (1 \text{ HFU/hours of minimum use}) \]

*Max. power output:* the maximum power output calculated by the programme, or possibly the minimum output.

*HFU:*

Hours of full use = total annual kWh output/maximum output
See also:

Results > From Grid Electricity Costs
13.2.7.3.1 Load Price

This dialog is used to define the demand price for the electricity tariff. Different entry fields are activated depending on what form of power measurement is selected, so that additional specifications can be entered.

**Number of Maximums Allowed For**
(only for Standard Calculation and Heavy/Light Load Maximums in the Power Measurement dialog)

**Heavy Load:**
The number of monthly maximums is entered here. The heavy load peak is calculated from the average of these monthly maximums. With the standard calculation the heavy load peak corresponds to the billing load.

**Light Load:**
(only for Heavy/Light Load Maximums in the Power Measurement dialog)
With power measurement using Heavy/Light Load Maximums, light load maximums are considered under certain conditions. Here the number of monthly maximums is entered, from which the light load peak is calculated.

**Include Light Load Maximums:**
(only for Heavy/Light Load Maximums in the Power Measurement dialog)
This factor describes which percentage of light load additional output is included in the billing load calculation.

**Inflation:**
The prices to be entered in this table are base prices that, multiplied with the Inflation, give the load price per KW. With the Inflation the grid utility company takes the current energy price and eg. wage increases into account. Normally, only the basic price level is used in the low voltage range, so that in this case the Inflation is 1.

**Pricing by Total kWh:**
Instead of giving price bands or price zones for the load price via the billing load, in this case the load price is given by annual electricity consumption in kWh.

Staggered Consumption Regulation: see Kilowatt-Hour Price

**Consumption Zone Regulation:** see Kilowatt-Hour Price
Measurement Only During HT Periods: (only for 96 hour measurement in the Power Measurement dialog)

Corresponds to 96 hour measurement with time zone regulation. Here the output values during low tariff periods are not included, without changing the 96 hour measurement periods’ progressive intervals.
See also: From Grid Tariff
13.2.7.3.2 Heavy Load Periods

The heavy load periods for the grid are defined in this dialog.

Heavy Load Periods - Summer/Winter Different:

If you click on this button you are able to enter all the heavy load periods separately for summer and winter.

Heavy Load Periods – From... To:

If the heavy load periods for summer and winter are different, this is where you define the beginning and end of winter time for the heavy load periods. Entry of heavy load periods is made in date format dd.mm. .

New Heavy Load Periods Valid From:

With the assistance of this field you are able to define the days in the week that heavy load periods are valid on. The days of the week are given in the first column, so that it is clear for which day the time entered is valid.

Heavy Load Periods:

You are able to enter up to 5 time periods (from hour to hour) for each day of the week. Entry is made in time format.

See also:

From Grid Tariff
13.2.7.4 Discounts/Supplements

You can enter Discounts and Supplements from the electricity utility separately on the two pages provided.

See also:

From Grid Tariff
13.2.7.4.1 Discounts

**General Discount:**
Here you can enter rebates/discounts that are guaranteed regardless of consumption, e.g. a discount for electricity drawn at the 30 kV voltage level.

**Load Utilisation Period Discount:**
(only for Standard Calculation and Heavy/Light Load Maximums in the Power Measurement dialog)

The load utilisation period is the relationship of total annual energy drawn from the grid to the billing load, and is a measurement of the regularity of energy use. With some tariffs or special deals the electricity company gives the customer a discount from a point over a certain minimum load utilisation period. This discount is, as a rule, included in the total kilowatt-hour and load tariff payments. In the case that the discount is only observed for HT energy and the load price, it is referred to as the HT utilisation period rebate.

**Minimum Load Utilisation Period:**
A discount is first included in the calculation when the load utilisation period is above this figure. If the usage is below this figure, an additional charge does not have to be made in compensation.

**Load Utilisation Period Discount Valid for:**
Here you can select the payment categories for which the load utilisation period discount are valid for.

**Load Utilisation Period Discount by Formula:**
If this option is selected the load utilisation period discount is calculated using the following formula:

\[
\text{load utilisation period discount} = \text{Factor X} \times (\text{load utilisation period} - \text{minimum load utilisation period})
\]

**Load Utilisation Period:**
The relationship of total annual energy drawn from the grid to the billing load.

If the calculated load utilisation period discount exceeds the maximum load utilisation period discount, this figure (i.e. the greater) is observed.

**Load Utilisation Period Discount by Table:**
Instead of a linear climbing load utilisation period discount, it is also possible to account for price bands in a table. The discount table values can be entered in the Load Utilisation Period Discount dialog. Here it is also the case that a load utilisation period discount is first observed when the minimum load utilisation period is reached.

› See also:
Discounts

Supplements

From Grid Tariff
13.2.7.4.2 Load Utilisation Period Discount by Table

Instead of a linear climbing load utilisation period discount (see Discounts), it is also possible to account for price bands in a table. The discount table values can be entered in the Load Utilisation Period Discount dialog. Here it is also the case that a Load Utilisation Period Discount is first observed when the minimum load utilisation period is reached.

See also:

From Grid Tariff
13.2.7.4.3 Supplements

Supplements:
Here you can enter HT or LT energy and the load price, with any supplements, as a percentage figure.

Set Costs \([€/a]\): (eg accounting fees)
Set annual costs are entered here, such as measurement and billing costs, that must be paid regardless of the consumption.

› See also:
From Grid Tariff
Discounts
13.2.8 Feed-in Tariff

Unlike the other database files, the Feed-in Tariff can be selected and defined in both the
Conditions > Tariffs menu dialog and in the Economic Efficiency Calculation... dialog.
However, you can also define the Feed-in Tariff via the Databases menu in the main menu
bar.

A reference describing the data record can be entered in the upper text field.

Period of Validity for Tariff
For the first years, the Feed-in Tariff is usually set at a higher rate. Thus you can take
account of any subsidised electricity provided for a set period, following which the legally
set minimum rate is paid.

Feed-in Tariff after ... Years
Here you are able to define a different Feed-in Tariff which is received following the initial
period.

Number of Power Levels
Here you can set the number of Power Levels required to define the different Feed-in
Tariffs.

Tariff Zones/Graduated Tariff Rates
The method used for calculating the resulting Payment Received for Grid Supply varies
according to the selection of either Tariff Zones or Graduated Tariff Rates. If Tariff Zones
is selected, the result is an almost constant change in the payment, whereas the selection
of Graduated Tariff Rates produces a jump from one payment rate to the next when the
defined Power Level is reached.

Tariff Zones:
A mean Feed-in Tariff for all Power Levels up to the Installed PV Power is
calculated. For example:

0-30 kW - €1
From 30 kW - €0,50

A system size of 50 kW therefore produces a Payment Received for Grid Supply of
30/50*€1 + 20/50*€0,50 = €0,80 per kWh.

Graduated Tariff Rates:
In this case the Feed-in Tariff is calculated direct from the Installed Power. Using the
above example, this would result in a Payment Received for Grid Supply of €0,50 per
kWh on all electricity supplied.

Payment Received for Grid Supply – High Tariff/Low Tariff different
If this option is selected, an additional field appears in which you can enter the Feed-in
Tariff at two different rates: a High Tariff and a Low Tariff.
The timings for High and Low Tariffs are the same as those for the From Grid Tariff. The timings are therefore dependent on the From Grid Tariff.
13.2.9 Pollutants

You can define a new pollutants file here, which can then be loaded into a project from the Conditions/Pollutant Mix menu.

In the Text field a file reference describing the data record is given, that was entered when saving the file.

Different values are required for simulating grid connected and stand-alone systems.

Grid Connected Systems
In the first column you need to enter the specific pollutant emissions that occur on production of the electricity required to supply energy from the grid.

In the second column you need to enter the specific pollutant emissions that are avoided by feeding PV energy into the grid.

This kind of differentiation is necessary when it can be expected that the grid utility will use different power plants for producing high and low peak electricity. For example the energy fed into the grid could suppress basic load electricity production with energy drawn from the grid occurring during peak times.

Stand-Alone Systems
For stand-alone systems the pollutant emissions for the Back-up Generator are given.

Click on Load to load a new pollutant evaluation file from the database or on Save to save new specifications to the database.

All emissions files must have the file ending *.emm. The directory that appears on opening the dialog can be set under Options/Drives.

The database that comes with the programme consists of values from the Integrated Systems Total Emissions Model (GEMIS), published in 1990 by the German state of Hesse's Ministry for the Environment, Energy and Federal Matters.
**13.2.10 MPP Tracker (not available with PV*SOL®-N for grid connected systems only)**

MPP trackers are not standard system elements, but are produced especially for the various stand-alone systems. They are also partly integrated into other system parts (charge controller).

For the MPP tracker the following data is required:

**Reference:**
The text entered is shown as the file reference in the load file dialog.

**Nominal Output:**
The nominal output corresponds to the power output of the PV generator.

**Upper and Lower Voltage Levels for the MPP Range [V]:**
The MPP tracker functions within this voltage range. The MPP tracker finds the optimal voltage for the PV array within this range, so that the array's power output is maximized.

**MPP Adjustment Efficiency [%]:**
The adjustment efficiency provides a measurement of how close the MPP tracker's working point is to the PV array's maximum power point (MPP).

**Characteristic Curve – MPP Tracker:**
This button opens the "Characteristic Curve – MPP Tracker" dialog, so that you can enter the conversion efficiency depending on the input power. The programme requires seven values to be entered for the characteristic curve: the efficiency at 0, 5, 10, 20, 30, 50 and 100% of the nominal power.

Click on **Graph** to view the characteristic curve.

Click on **Load** to load one of the MPP tracker files provided, to check on the values and correct if required.

Click on **Save or Save as...** to save the values you have entered, either in the current file or as a new file. A message appears before a file is overwritten.

Close exits the dialog without any message appearing.
13.2.11 Loans

From here you can enter the parameters for any loans taken out to finance the PV system. Details on using the database are given under Project Design.

As in all database dialogs, there are the Load, Save and Close buttons and there is also a Print button.

The entry parameters for a loan are:

Reference
The reference, with a maximum text length of 50 characters, is required for selection in the Financing dialog of the Economic Efficiency Calculation.

Loan Capital
The amount of the loan is entered as a percentage of the investment volume.

Term
The time period that has been arranged for paying back the loan.

Loan Interest
The amount of interest that has to be paid on a loan.

Repayment-Free Initial Period
The years in which no loan repayment is required. A maximum period of two years is allowed.
14 Options Menu

The Options menu is used to enter specifications that are independent from the programme and to define the basic settings for the use of the programme.
### 14.1 Paths...

You are able to define the directories for all file types by clicking on the corresponding button. A directory dialog opens in which you can define a new directory path.

These settings are required in the programme for standard drive selection in the Load and Save File dialog.

The individual components are searched for and saved in the following standard sub-directories:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Projects</th>
<th>.prj</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PV-Modules</td>
<td>.mod</td>
</tr>
<tr>
<td></td>
<td>Inverter (Grid Connected)</td>
<td>.wrn</td>
</tr>
<tr>
<td></td>
<td>Inverter (Stand-Alone)</td>
<td>.wra</td>
</tr>
<tr>
<td></td>
<td>Batteries</td>
<td>.acc</td>
</tr>
<tr>
<td></td>
<td>To Grid Tariff</td>
<td>.eta</td>
</tr>
<tr>
<td></td>
<td>From Grid Tariff</td>
<td>.tar</td>
</tr>
<tr>
<td></td>
<td>Loads</td>
<td>.slg</td>
</tr>
<tr>
<td></td>
<td>Individual Appliances</td>
<td>.vbi</td>
</tr>
<tr>
<td></td>
<td>Pollutants</td>
<td>.emm</td>
</tr>
<tr>
<td></td>
<td>MPP Tracker</td>
<td>.mpp</td>
</tr>
<tr>
<td></td>
<td>Shade</td>
<td>.sch</td>
</tr>
<tr>
<td></td>
<td>Loans</td>
<td>.cre</td>
</tr>
</tbody>
</table>
14.2 Settings

Options > Settings

These settings stay put after closing a project.

Projects
- On the worksheet, Projects, you can specify with which project the programme should open. You can select that either a new project or the last project worked on appears each time the programme is started.
- “No monitoring of project components” gives you the option of selecting that various Messages appear (click on field) or do not appear (leave field blank) during programme use:
- Select a standard feed-in tariff for new projects. This should be an .eta-file. The selected tariff is displayed.
- Select either metric or imperial (U.K.) units.

see Project Design.

System Check
Here you can enter the settings that are required for the System Check.

Temperature and irradiation maximums are usually calculated from the Climate data file.

However, if you are certain about the maximum values that you wish to use as the basis for system calculation, you can enter these as the set values.

Background Image
Define whether the current system or an uploaded image should be the program background.
Load an image for grid connected systems and stand-alone systems, each.

Calculation Model
Select whether the Dynamic Temperature Model or the Linear Temperature Model is to be used.

Please note that these setting remain in force after you exit the project.

Project report
Define your company's contact data for the project report.

Define Company Logo for Project Report Heading
Select a logo to appear in the header of the project report.

If you select “Show Company Logo on Screen”, the logo appears on PV*SOL’s main screen as a background image.
Update Check

→ Prerequisite: active internet connection

Proxy settings: PV*SOL Expert is using your computer’s system proxy settings to connect to the network.

→ The program checks whether a new update is available on the server according to the settings on the page Internet update:

- Daily at first program start
- Or on clicking Check now ...
- If you are using a proxy server, you can enter the required settings here.
- If a new release or new databases are available, the program will close and the installation program will be downloaded to the Desktop and run from there.

→ See also:

Message: ... Database file ...
Database Monitoring System
14.2.1 Message: ... Database file ...

The database file has been changed! Load file data into your project?

Components from the corresponding Database are loaded from the dialogs: Tariffs, Polutant mix, Technical Data and the load pattern in the Electrical Appliances dialog. The programme loads the corresponding values and notes the file name.

If you change the database files that have been loaded or saved in a project, the programme informs you before simulation, that you have made changes to the database file without loading the new values into the project.

If you answer YES the project data is updated with the corresponding amended database data; if you answer NO the original values are retained.

Because all the database files that are loaded into a project are checked before simulation, you can click on Accept All so that you only have to answer the question once.

Cancel ends not only the data checks, but also the simulation.

This message appears for modules and inverters, and also on opening the technical data dialog.

No data checks for “To Grid Tariffs”!
14.2.2 Database Monitoring System

When a mismatch is uncovered by the database monitoring system, a corresponding message appears on screen. For example:

1. In PV Array 1 no module file has been selected from the database! Do you want to select a PV module?
   If so click on the PV Module button.

2. The database file for the module data in PV Array 1 no longer exists!
   Do you want to save the data to a new file?

3. The database file \
   c:\pvsol\biblio\module\mei76.mod
   has been changed!
   Load file data into your project?

Checks 1 and 2 take place when the corresponding dialog (Tariffs, Technical Data, Appliances) is closed with “OK”. These messages are for information and can be closed by clicking on “No”.

Check 3 takes place before simulation and, for modules and inverters, additionally when the “Technical Data” dialog is opened.

It is best to answer “Yes” to the question “Load file data into your project?” (except in the instance when you open an old project and want to simulate the old conditions), or to select “Accept All” beforehand. (see Message: ... Database File...).
15 Language Menu

PV*SOL® currently offers a selection of the following languages: English, French, German, Italian, Spanish.
16 Help Menu

Menu Help

Contents opens the help - You always get context-sensitive help using the F1 key.

Click Internet Service in order to
- download an Order Form,
- visit the Valentin Energiesoftware homepage, which is opened in your internet browser or
- check for Updates of the program or the databases.


Manual 3D Visualization opens the manual for design using the 3D visualization as .pdf file.

Under Help > Info, you will find

General information
Program and release number, contact data for Dr. Valentin Energiesoftware GmbH.
View licence contract

Further information
Version numbers for all program files, automatically gathered information on your operating system and hardware.

Registration
Register by entering the serial number and activation code. If you have an internet connection, you can register here or access an order form on our website.

Change the PV*SOL Expert version by using the Change Registration button.

For example, this is necessary if you want to convert a time-limited version to a full version, or the Grid-Connected-Only version to the version for both Grid Connected and Stand-Alone Systems.
17 Glossary

Array – see PV Array.

Back-up Generator – Direct Energy Use
If a back-up generator is specified in the system configuration, the energy generated by the back-up generator and the energy used directly by the appliances is identified. With direct current appliances, the alternating current is converted to direct current by the battery charger.

Back-up Generator - Energy
The energy generated by the back-up generator includes direct energy consumption and the energy used to charge the battery.

Back-up Generator – Fuel Consumption
If a back-up generator is used, the annual fuel requirement needs to be specified. The fuel consumption is calculated from the energy generated by the back-up generator and the specific fuel requirement entered.

Battery - Charge
The total energy going into the battery (or the batteries) is shown. If the system is simulated without a back-up generator, this corresponds to the solar energy charge.

Battery –Charge, Solar
For systems with a back-up generator, the portion of the charge that comes from solar energy is given separately. The difference from the total charge comes from the back-up generator’s portion.

Battery – Charge Condition
The battery’s charge condition at the start of simulation can be defined in the system configuration (default = 30%)

Battery – Content, Back-up Generator (After Simulation)
This value appears only when a back-up generator is used. It describes the proportion of energy produced by the back-up generator that is available in the battery at the end of the simulation period.

Battery – Content, Solar (After Simulation)
The proportion of solar energy available in the battery at the end of the simulation period is given.

Battery - Discharge
The total energy from the battery (or the batteries) is shown. If the system is simulated without a back-up generator, this corresponds to the discharge of solar energy.
Battery – Discharge, Solar
For systems with a back-up generator, the proportion of discharge that is based on solar energy is given separately. The difference from the total discharge comes from the back-up generator’s portion.

Battery - Losses
Battery losses come from the battery efficiencies during charge and discharge, and self-discharge.

Battery - Performance Ratio
The battery’s performance ratio is the relationship between discharge and charge.

Charge Condition at Simulation Start/End
The battery’s charge condition at the start of simulation (defined in the system configuration) and the calculated charge condition at the end of simulation is shown.

Consumption - Requirement
The requirement is the sum of the annual energy requirement of all defined Appliances. If no appliances have been defined, this value is not given. You are also able to define appliances if the “Full Supply” to grid concept has been selected.

Consumption – Covered by Solar Energy
The consumption covered by solar energy is made up of direct energy use and the solar portion of the battery charge.

Consumption – Not Covered
The consumption requirement that cannot be covered by the system is shown as the amount of energy required that cannot be provided either by the PV array or by the battery.

Electricity Production Costs
The Electricity Production Costs are the annual costs divided by the amount of electricity produced.

The annual costs result from the: Cash value of annual costs, One-off Payments, Loan Payments, Self-Financing

Multiplied by the Annuity Factor. Energy Converter
This dimension is only shown if MPP tracking is going to be used. The losses that occur when using an MPP tracker are subtracted from the generated energy.

Energy Requirement - Covered by PV Generator
This dimension is only given when the "Own Use” concept is selected. It is the energy generated by the solar system that is used to cover the energy requirement of the appliances.
**Definitions**

**External Temperature**
The external temperature is a specification taken from the climate data files. It is required to define the module temperature, as the module efficiency is dependent on the temperature (see PV Module).

**Generated Solar Energy (Alternating Current Side)**
The generated solar energy (AC side) is the energy after conversion of the PV direct current into alternating current, which can either be fed into the grid or used to cover the load requirement. The energy used by the inverter itself is not taken into account.

**Generated Solar Energy (Direct Current Side)**
When designing a PV system, the energy that is produced by the PV modules is also of interest, ie the energy flow before entry into inverter.

**Grid, Electricity From**
If all the energy produced by the PV system is fed into the grid, the total load requirement and the inverter's own consumption will have to be covered by electricity drawn from the grid. If the "Own Use" concept is selected, the energy drawn from the grid is reduced by the proportion of PV generated energy that is used to cover the load requirement.

**Grid, Electricity To**
If the "Full Supply” to grid concept is selected (see Tariffs), all solar energy generated is fed into the grid and this dimension is not given. If the "Own Use” concept is selected, only the proportion of energy that is not used by the appliances is exported to the grid.

**Inverter Efficiency**
The inverter efficiency is the energy generated on the alternating current side in relation to the energy fed into the direct current side.

The efficiency is made up of the Inverter Characteristic Curve, the MPP adjustment efficiencies (see Inverter Database) and the inverter's own consumption.

A very poor inverter efficiency (in comparison to maximum efficiency) is above all possible if the inverter is oversized or because its maximum nominal output limits the PV power output.

**Irradiation onto Tilted Array Surface**
The irradiation onto the tilted Array surface is the energy (after subtraction of shade) on the PV surface that is available for conversion. A proportion of this energy is lost through reflection on the module's surface.

**Module Temperature**
There are two different Temperature Models in the programme. Module temperature definition is dependent on the climate data, module specific parameters and the type of mount. The module temperature for each array is given on each array worksheet.
Own Consumption - PV System
The PV system’s own consumption comes from the energy used by the inverter, when no PV energy is being produced. During the day, the inverter draws on the grid for its stand-by consumption. At night, if the inverter is not switched off completely, it also draws energy for night consumption. Both dimensions are entered in the characteristics for the Inverter.

Net Present Value
The Net Present Value is calculated from the:
- Cash Value of all Annual Costs
- Cash Value of all Annual Lodgements and Savings
- Cash Value of Loan Payments
- Cash Value of Tax Payments
- One-off Payments
- Subsidies
- Self-Financing

Payback Period
The period required to get to the point when the net present value of the investment first becomes positive.

Performance Ratio
The performance ratio is a measurement of the energy losses within the system that occur in comparison with the system's nominal output. The nominal output is calculated from the irradiation onto the tilted PV surface multiplied by the module efficiency under standard test conditions (25 C, 1000W/m²).

PV Array – Direct Energy Use
Direct energy use means the energy that flows direct (without being stored before use) to the appliances. With alternating current appliances, however, the energy will have to be converted to AC by the stand-alone system inverter, before it can be used to cover electricity consumption.

PV Array – Energy Surplus
An energy surplus occurs if the solar energy available is not required by the appliances and the battery is charged.

PV Array – Generated Energy
The generated energy is the energy exiting the PV generator. Losses through MPP tracking are not accounted for. These dimensions also include any PV array surplus that may occur.
**PV Array - Irradiation**
The irradiation onto the tilted PV array surface is the solar energy that remains available after subtraction of shade. A proportion of this energy is lost through module surface reflection.

**PV Array - Efficiency**
The PV efficiency is the DC energy produced in relation to the total energy irradiated onto the array surface. Here the inverter’s efficiency and the cabling losses are not taken into account, as they are during the system efficiency calculation.

The array efficiency takes the following into account:
- the reflection losses at the module surface,
- the PV module’s efficiency, ie the characteristic curve for the PV module and the temperature coefficient for PV output (see PV Module database), and
- the array’s Additional Losses.

**PV Array - Radiation**
The programme uses a radiation processor to convert horizontal radiation into radiation onto the tilted surface using the following dimensions: the degree of latitude, the angle of inclination, the azimuth and the albedo.

**Radiation Minus Reflection**
Part of the radiation onto the PV surface is lost due to reflection losses on the module surface. The direct radiation is reduced by the module incident angle modifier (see also: PV Module)

**Radiation onto the Horizontal**
The horizontal radiation is taken from the Climate Data Files.

**Radiation Without Shade**
If the array is shaded for a period, the radiation that would fall onto the tilted PV surface if the surface was not shaded is identified.

**Solar Coverage Proportion (Grid Connected)**
The proportion of solar coverage is the generated energy (after subtraction of the inverter’s own consumption) in relation to the load requirement. It is only of interest for the “Own Use” concept (see Tariffs) and is only given if an electrical appliance is defined. The solar coverage proportion does not express how much of the generated energy can be used in direct load coverage.

**Solar Coverage Proportion (Stand-Alone)**
The proportion of solar coverage is the relationship of the consumption covered by solar energy and the energy requirement. The consumption covered by solar energy comes from direct energy use and the solar portion of the battery charge.
Specific Annual Yield
The specific annual yield is an evaluation dimension that gives the system's annual yield standardised to the installed output. In other words, the specific annual yield corresponds to the system's peak load operating hours.

Another well known evaluation dimension is calculated from the specific annual yield: the final yield. The final yield is the specific annual yield divided by 365 days.

System Efficiency
The system efficiency is the quotient from the usable solar energy from the PV system and the total energy irradiated onto the generator surface. It is made up of the PV array efficiency, the inverter efficiency and the cabling losses.

Wind Speed at a Height of 10m
The wind speed is accounted for when defining the module temperature in the dynamic Temperature model. In the climate data files provided the wind speed is measured at a height of 10 metres.
# 18 Index

## A
- Annual Energy Balance .......................................................... 139
- Appliances ........................................................................... 48, 49, 52
- Appliances by Load Profile .................................................. 49, 50, 51
- Array ................................................................................... 62
- Assessment Period ............................................................... 116
- Azimuth ................................................................................ 96

## B
- Background Image ................................................................ 186
- Back-up Generator .............................................................. 68, 134
- Basic Parameters .................................................................. 132
- Battery .................................................................................. 66, 168

## C
- Calculation Basis ..................................................................... 114
- Calculation Model .................................................................. 98, 186
- Calculations .......................................................................... 33, 109, 111, 112
- Characteristic Curve ............................................................... 167
- Charge Controller ................................................................. 67
- Climate Files ......................................................................... 45
- Components .......................................................................... 25, 32
- Conditions .............................................................................. 44, 45, 46, 47
- Consumption Costs ............................................................... 123
- Contact Data ......................................................................... 186
- Copy 2D object ...................................................................... 79
- Cost Groups .......................................................................... 118
- Costs ..................................................................................... 133

## D
- Database .................................................................................. 32, 53, 158, 164, 166, 168, 169, 180, 181, 182, 183, 188, 189
- Definitions .............................................................................. 192
- Degradation .......................................................................... 114, 117
- Delete 2D object .................................................................... 79
- Depreciation .......................................................................... 126
- Detailed Project Report .......................................................... 153
- Discount Economic Efficiency .............................................. 125
- Discounts ............................................................................... 177
- Discounts/Supplements ......................................................... 176

## E
- Economic Efficiency Calculation .......................................... 112, 113, 114, 116, 117, 118, 119, 120, 121, 122, 123, 124, 126, 127, 128, 130, 131
- Balancing of Costs ................................................................. 118
- Calculation Basis .................................................................... 114
- Consumption Costs ............................................................. 123
- General Parameters ............................................................. 116
- Graphics ............................................................................... 128
- Grid Connected Systems ....................................................... 113, 180
- Investment Costs ................................................................. 119
- Loan ...................................................................................... 125
- One-off Payments ................................................................. 120
- Operating Costs ................................................................. 122
- Other Costs .......................................................................... 121
- Report ................................................................................. 130
- Results ................................................................................... 127, 136
- Stand-Alone Systems ........................................................... 132, 133, 134, 135
- Subsidies ............................................................................. 124
- Tables ..................................................................................... 129
- Tax ....................................................................................... 126
- Electrical Appliances by Load Profile .................................. 50
- Energy and Climate Data ....................................................... 140
- Exit ....................................................................................... 43

## F
- File ......................................................................................... 34, 40, 41, 42, 43
- File Types ............................................................................... 185
- Financing ............................................................................... 135
- From Grid Tariff169, 170, 171, 172, 176, 177, 178, 179

## G
- Graphics .................................................................................. 128, 140, 141
- Formatting of Graphs ............................................................ 143
- Formatting the X-Axis ............................................................ 144
- Formatting the Y-Axis ............................................................ 145
- Graphics in Table Format ..................................................... 147
- Graphics Screen .................................................................... 141, 143, 144, 145, 146
- Grid Connected Systems ...................................................... 38, 113
- Grid Electricity Costs ............................................................ 149

## H
- Heavy Load Periods ............................................................... 175
- Help ....................................................................................... 191
- Holiday Periods ................................................................. 106
- Horizon ............................................................................... 106

## I
- Imperial Units ........................................................................ 186
- Individual Appliances ........................................................... 56, 57, 58, 59
- Appliances ............................................................................ 53
- Individual Appliances Consumption ..................................... 52
- Info ....................................................................................... 181
- Interest on Capital .............................................................. 116
- Internet Service ................................................................. 191
Inverter .......................................................... 73, 167
Inverter Grid Connected Systems .................... 164
Inverter Stand-Alone Systems .......................... 166
Investment Costs ............................................. 119

K
Kilowatt-Hour Price ........................................... 171

L
Language ................................................................ 190
Light ................................................................... 58
Load ................................................................... 32
Load Price .......................................................... 174
Load Utilisation Period Discount by Table ........... 178
Loans .................................................................. 183
Location ............................................................ 45
Logo ................................................................... 186
Losses ............................................................... 98

M
Main Screen ........................................................ 27
Menu_34, 35, 44, 48, 60, 109, 138, 158, 184, 190, 191
Message ............................................................ 188
Messages ........................................................... 101
MeteoSyn ............................................................ 45
Metric Units ........................................................ 186
Modules .............................................................. 77, 96
Monitoring System ............................................. 189
MPP Tracker ....................................................... 182

N
New Project ........................................................... 35
New Sketch .......................................................... 106
Number .............................................................. 73

O
One-off Payments ............................................... 120
Open ................................................................... 41
Operating Costs .................................................. 122
Operating Instructions ......................................... 26
Options ................................................................ 184, 185, 186
Orientation .......................................................... 96
Other Costs ......................................................... 121
Output ............................................................... 154, 155, 157
Output Losses ...................................................... 117

P
Parameters .......................................................... 132
Part Load Operation ............................................. 163
Paths .................................................................. 185
Payment Received for Grid Supply ....................... 148

Q
Quick Design ....................................................... 36, 37, 38

R
Reduction in Module Power .................................. 114
Registration .......................................................... 191
Report .................................................................. 130
Results ............................................................... 127, 138, 139, 148, 149, 150, 151, 156
Results Overview ............................................... 136
Rotating Net Yield ............................................... 116

S
Sales Tax ............................................................. 116
Save ................................................................... 32, 42
Screen .................................................................. 141
Service Period ..................................................... 116
Settings .............................................................. 186
Shade .................................................................. 106
Shade Object ........................................................ 108
Short-Time Use Appliance .................................... 59
Simulation .......................................................... 33, 111
Stand-Alone Inverter ........................................... 65
Stand-Alone Systems .......................................... 37
Sub-Array ............................................................ 62
Subsidies ............................................................ 124
Summary Project Report ....................................... 152
Supplements ....................................................... 179
System ............................................................... 60, 61, 106
System Check ...................................................... 101
System Diagram .................................................. 105
System Operation Start Date ............................... 114
System Requirements ......................................... 4

T
Table .................................................................. 157
Tables .................................................................. 129
Tariff Time Periods .................................................. 170
Tariffs ........................................................................ 47
Tax........................................................................... 126
Technical Data.... 61, 62, 63, 64, 65, 66, 68, 69, 71, 105
Technical data Grid Connected ................................. 69
Technical Data Stand-Alone ...................................... 63
Technical Date .......................................................... 67
Temperature Model ................................................ 186
To Grid Credit .......................................................... 148
To Grid Tariff ........................................................... 148, 180
Type of Mount .......................................................... 77

U

Unit System ............................................................. 186
User-Dependent Appliance ............................. 57
User-Independent Appliance ......................... 56

V

Variant Comparison ........................................ 156, 157
View Page Layout ................................................... 154

Y

Yield ........................................................................ 116